# Table of Contents

## INTRODUCTION

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>1</td>
</tr>
<tr>
<td>Software License Agreement</td>
<td>2</td>
</tr>
<tr>
<td>Acquiring Technical Support</td>
<td>3</td>
</tr>
<tr>
<td>Update Service Agreement</td>
<td>3</td>
</tr>
<tr>
<td>Registration</td>
<td>4</td>
</tr>
<tr>
<td>System Requirements</td>
<td>5</td>
</tr>
<tr>
<td>Year 2000 Compliant</td>
<td>5</td>
</tr>
<tr>
<td>Manual Conventions</td>
<td>6</td>
</tr>
<tr>
<td>Visual Cues</td>
<td>6</td>
</tr>
<tr>
<td>Manual Text Styles</td>
<td>6</td>
</tr>
<tr>
<td>Keyboard Operations</td>
<td>6</td>
</tr>
</tbody>
</table>

## INSTALLATION

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing GrandMaster Suite</td>
<td>7</td>
</tr>
<tr>
<td>Windows 95/NT Installation - CD ROM</td>
<td>8</td>
</tr>
<tr>
<td>Windows 95/NT Installation - (32 Bit) Nine Diskettes</td>
<td>12</td>
</tr>
<tr>
<td>Installation - License Windows 95 and Windows NT</td>
<td>17</td>
</tr>
<tr>
<td>Windows 3.1 (16 Bit) Installation CD-Rom</td>
<td>20</td>
</tr>
<tr>
<td>Windows 3.1 (16 Bit) Installation - Six Diskettes</td>
<td>24</td>
</tr>
<tr>
<td>Installation-License-Windows 3.1</td>
<td>28</td>
</tr>
<tr>
<td>OS/2 Installation- CDROM</td>
<td>31</td>
</tr>
</tbody>
</table>
OS/2 Installation - Six Diskettes .................................................. 35
Installation - License - OS/2 .......................................................... 39
Other Installation Considerations ...................................................... 42
Installation of Software Updates ...................................................... 42
AUTOEXEC.BAT Commands .......................................................... 43
Special Note for Windows 95 and Windows NT Install ......................... 44
Installation of 32 bit Software ....................................................... 45
Problem Resolution ................................................................. 45
DOS and Network File Resources .................................................. 46
Windows 3.1 and Windows 95/NT ................................................... 46
Peer to Peer Network Setup - Windows 95 and Windows NT .................. 47
Prime Workstation where GrandMaster Suite will be resident ................. 47
Other Workstations that will access GrandMaster Suite ....................... 48
GrandMaster Suite Windows and GM II .......................................... 49
GM II Setup Considerations ....................................................... 49
On-Line Documentation ............................................................ 51
Obtaining Software Updates ........................................................ 51
Problems locating the license file ................................................... 52

THE BASICS 53

System Startup Processing .......................................................... 53
The Basic Elements of the GrandMaster System Manager ..................... 54
The Logon ............................................................. 54
The Main Screen ............................................................ 55
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Screen Help</td>
<td>56</td>
</tr>
<tr>
<td>The Menu System</td>
<td>57</td>
</tr>
<tr>
<td>Dialog Boxes</td>
<td>58</td>
</tr>
<tr>
<td>Selection Lists</td>
<td>59</td>
</tr>
<tr>
<td>The On-Line Help System</td>
<td>60</td>
</tr>
<tr>
<td>HELP Main Menu</td>
<td>60</td>
</tr>
<tr>
<td>Help Index</td>
<td>61</td>
</tr>
<tr>
<td>Context-sensitive Help</td>
<td>61</td>
</tr>
<tr>
<td>Printer Setup</td>
<td>62</td>
</tr>
<tr>
<td>Printer Support</td>
<td>63</td>
</tr>
<tr>
<td>Backing Up Your Files</td>
<td>64</td>
</tr>
</tbody>
</table>

**CONVERSION**                                                                 |
| Page |

- Payroll Conversion - GrandMaster II                      | 66   |
- Conversion Procedure Steps                               | 67   |
- Set the GM II file location                              | 68   |
- Creating the Suite payroll                               | 69   |
- Select and convert the payrolls                          | 71   |
- Conversion Process                                       | 74   |
- Confirm the conversion processing                        | 75   |
- Payroll Conversion - GrandMaster I                       | 76   |
- Conversion Procedure Steps                               | 77   |
- Run the GM2PREP Program                                  | 78   |
- Creating the Suite payroll                               | 81   |
Select and convert the payrolls .................................................. 83
Conversion Process ..................................................................... 84
Confirm the conversion processing .............................................. 85
Convert Homecare Clients ......................................................... 86
New Customers of GrandMaster Suite Payroll ............................. 88

MANAGING ADMINISTRATION .............................................. 91

Main Administration Module ..................................................... 92
Update User ID’s ....................................................................... 94
Setting a Password ..................................................................... 96
Restricting Access ..................................................................... 97
Global Preferences .................................................................... 110
General Ledger Definition .......................................................... 112
Initialization Parameters ............................................................. 114

UTILITIES ........................................................................... 117

Start Utility Program .................................................................. 118
Utility Programs ......................................................................... 119

APPENDIX ............................................................................ I

File System Errors ..................................................................... I
Error Codes ................................................................................ II
OVERVIEW ............................................................................ VI
Indexed File Reorganization ....................................................... VI
Recovery of Corrupt Indexed Files ............................................. VI
Rebuild file Index Utility ......................................................... VII
OPERATION ........................................................................ VIII
Rebuild Options ................................................................. IX
Examples of Operation ....................................................... XV
Parameter Files ................................................................. XVI
Redirect of Information ..................................................... XVII
General Notes ................................................................ XVIII
SYSTEM PARAMETERS ....................................................... XVIII
ERROR, INFORMATION AND WARNING MESSAGES ................ XIX
Errors .............................................................................. XIX
Command Line Errors: ...................................................... XIX
Rebuild Errors: ................................................................. XXIII
Information Messages ...................................................... XXVI
Warning Messages .......................................................... XXVI
Welcome

Welcome to Can-Pay's **GrandMaster Suite of Applications**. A fully integrated Windows or OS/2 group of products developed in Canada for Canadian requirements. Can-Pay, specializing in Canadian payroll and payroll related software since 1985, has developed this unique suite of software. CanPay's previous products, the GrandMaster and GrandMaster II payroll system has become well renowned for handling complex Canadian payroll situations.

The integration of Human Resource, Scheduling, Time Keeping, and Resource Planning modules with Can-Pay's vast payroll experience provide a strong, fully integrated product to fulfill all of your payroll/personnel requirements.

The features of the suite include:

1. Administration module - controls the use and access to other modules within the group.

2. Payroll - provides the most advanced payroll system available in the personal computer market place.

3. Human Resources - provides direct access to information from payroll calculations, scheduling, time keeping, and organization charts to provide an effective personnel management tool.

4. Scheduling - allows for the creation of work schedules with rotation patterns.

5. Time Keeping - introduces work rules to scheduling modules and allows for data entry of hours or direct import from electronic time clocks.

6. Resource Planning - allows you to develop an employment needs structure to be fulfilled by the scheduling module.

7. Electronic Funds Transfer - organized payroll cheque information for transmission to any Canadian bank.

8. Labour Distribution - gives the capability of providing labour analysis by a variety of classification break downs.

Can-Pay is committed to customer satisfaction by specializing in satisfying payroll needs. We possess an extensive expertise of payroll requirements and make responding to customer needs our priority.

We hope you enjoy the GrandMaster Suite, and we hope to maintain a long-lasting relationship!
Software License Agreement

Can-Pay provides this Program and a License for its use to the original Purchaser. This program is protected by copyright laws and the Purchaser agrees to abide by these regulations. The program may consist of one or more modules, each designed to work as a group to achieve a desired result. This license agreement covers all modules of the GrandMaster Suite. The modules can consist of the following:

<table>
<thead>
<tr>
<th>Administration</th>
<th>Labour Distribution</th>
<th>Resource Planning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payroll</td>
<td>Time Keeping</td>
<td>Homecare</td>
</tr>
<tr>
<td>Human Resources</td>
<td>Electronic Funds Transfer</td>
<td>Option Applications</td>
</tr>
<tr>
<td>Schedule</td>
<td>Bank Reconciliation</td>
<td></td>
</tr>
</tbody>
</table>

The Purchaser remains solely responsible for selecting the Program to achieve the intended results, and for the installation and use of the Program. The License entitles the Purchaser to:

- Install the Program on a single machine which may be a computer local area network, in which case, multi-users may access the single copy of the Program.

- Make copies of the Program for backup.

- Apply for Update Service for which the Purchaser will pay an annual fee. Can-Pay will revise or update the Program as required.

**Program Limitation:**

The use of the Program is limited to 20 employees unless the Purchaser has obtained a License Program from Can-Pay to expand the limitation. The License Program will have an expiry date at which time the expanded limitation will revert back to 20 employees.

**Terms:**

The license is in effect until terminated or until the Purchaser terminates the license by failing to pay the Annual Service fee within 30 days of receipt of invoice. The License may be terminated at any time by returning the Program together with the backup copy and all documentation to Can-Pay.

**Confidentiality:**

The Purchaser acknowledges that the Program is confidential in nature and of great value and agrees to take reasonable precautions to keep the Program confidential.

**Limited Warranty:**

Can-Pay limits its warranty to the replacement of defective diskette(s) on which the Program is recorded. Can-Pay makes no other warranties, either expressed or implied. Can-Pay reserves the right to change the characteristics of the Program over a period of time, without notice to the Purchaser.

**Liability:**

Can-Pay shall not be liable for the inability of the Program to perform a function or the accuracy of the results, nor for indirect, special or consequential damage such as loss of profits or inability to use the Program.
Acquiring Technical Support

The License Program contains the full name and address of the license holder and a product serial number. You will be requested to provide this serial number when calling for technical support. You **MUST** retain your license diskette for later use as some updates may require that you re-install the license after a software update. Please see the Installation Chapter, for information about how to install the GrandMaster Suite license.

Update Service Agreement

The Update Service Agreement entitles the registered user of GrandMaster Suite to receive regular updates to the programs. Can-Pay agrees to monitor changes in provincial and federal regulations and further agrees to keep abreast of user requirements and changing trends in payroll. When deemed necessary or advisable by Can-Pay, the Program will be updated to current specifications and new program diskettes will be promptly forwarded to each registered user.

In order to receive the update service, the original purchaser must complete the attached Update Service Card and forward it to Can-Pay, along with proof of purchase, within 30 days of purchase. The first year of service is included in the purchase price, after which the user will be invoiced annually on the purchase anniversary date. Can-Pay reserves the right to change the cost of this service without notice.

Upon receipt of the Update Service Card, Can-Pay will ensure the user's software complies with current government regulations and will continue to provide updates while this agreement is in force.
Registration

It is important to you to fill out and send in your registration card as soon as possible. Please include the update service card, and proof of purchase within 30 days of purchase. Please advise us at the same time of the preferred method of update service, either by diskettes or CDROM. It is also important to advise us of your current operating system in order for us to send the correct update format. Registration entitles you to:

- 1 year of update service and technical assistance to applicable modules.
- Eligibility for further upgrades, as warranted by user requirements and changes in provincial and federal regulations
- Assurance that the version of software you purchase meets current statutory requirements.
System Requirements

The GrandMaster Suite of programs is designed to run on a Personal Computer with the following attributes:

- CPU – 486 or higher for Windows 3.1 and OS/2 Pentium for Windows 95/NT
- RAM (memory) – minimum 8 megabytes for Windows 3.1; 32 megabytes for Windows 95; 64 Megabytes for Windows NT and 16 megabytes for OS/2 Warp version 4 or better. These are recommended minimums.
- Hard Drive – at least 30 MB free for program files, 100 MB free for data files, using as an example the approximate data space required per year for a 200 person payroll.
- Display – colour SVGA 800 x 600 recommended
- Operating System – Windows 3.x, Windows 95 or OS/2 Warp 4.x or Windows NT
- Network - Novell, OS/2 Warp Server, Windows, NT
- Back Up - Third party facility with sufficient capacity to back up system data files.

Year 2000 Compliant

The GrandMaster Suite of programs was designed to work for you for many years to come including the transition through the turn of the century. The GrandMaster Suite of programs is Year 2000 compliant and will continue to operate correctly. However, it is dependent on the environment where it is installed. You should ensure that your hardware and operating system are also Year 2000 compliant.
Manual Conventions

To help the user locate and interpret information easily, this manual employs consistent visual cues and text formats. These conventions are as follows:

Visual Cues

Examples are shown within lines as follows:

Example: This is a sample “example box”.

Notes are indicated with a hand symbol.

Warnings are indicated with a “skull-and-crossbones”.

Manual Text Styles

Lead-in Text

This provides quick, easy access to information throughout the manual.

Text Formats

ALL CAPITALS are used to refer to directory names and filenames.

Example: The hard drive location C:\GMSUITE

Capitalized Bold is used to represent menu options.

Example: Select the Add Payroll option from the File menu.
(means to open the “File” menu and select the option called “Add Payroll”)

SMALL CAPITALS are reserved for names of keys on the keyboard and buttons on the screen.

Example: press ALT
(means press the “ALT” key on the keyboard)

Keyboard Operations

KEY1 + KEY2 The plus sign (+) indicates that KEY1 is to be held down while you press KEY2.

KEY1, KEY2 The comma (,) indicates that KEY1 is to be pressed and released, followed by KEY2 being pressed and released.
Installing GrandMaster Suite

This section will describe the steps necessary to install the GrandMaster Suite. Before attempting an installation, please check the system requirements in the Introduction Section of this manual for the minimum system configuration.

The GrandMaster Suite of programs is distributed as a set of diskettes or as a CD-ROM. The GrandMaster Suite of programs is also available to be downloaded from our website.

There are several installation procedures outlined in the following pages. Select the appropriate method for your requirements. Before proceeding with the installation please also review carefully the section of the chapter entitled “Other Installation Considerations” GrandMaster Suite - Contents of CD-ROM.

This CD-ROM contains the distribution kits for all operating systems supported for GrandMaster Suite. The CD-ROM also contains the documentation for GrandMaster Suite in Adobe Acrobat format (PDF Files) and the installation programs for Acrobat Reader V3.0 for Windows 3.1, Windows 95/NT and OS/2.

You install the GrandMaster Suite of programs by running the Install programs from the directory that is appropriate to your operating system. The installation program will automatically determine if the program was previously installed and will update the previous installation.

The directories present on the CD-ROM are:

- Windows
- OS/2
- Windows 95NT
- Acrobat
- DOC

GrandMaster Suite for Windows (16 Bit)
GrandMaster Suite for OS/2
GrandMaster Suite for Windows (32 Bit)
Acrobat Reader for Windows and OS/2
GrandMaster Suite Documentation in PDF Format

The root directory of the CD-ROM contains a readme file detailing the contents of the CD-ROM and the RELNOTES.TXT file. The RELNOTES.TXT file contains a list of the changes and corrections to the GrandMaster Suite Software.
1. Insert CD-ROM into CD Drive

2. The Installation program is automatically started when this CD-ROM is inserted into a Windows 95 or Windows NT CD-ROM Drive that has Auto Run enabled.

Or

3. If AutoRun is not enabled, go to “My Computer” and open CD-ROM icon. Double click on the WIN95NT folder. The software is installed for Windows 95 and Windows NT by executing the INSTALL.EXE program in the \Win95NT directory.

4. When the necessary files have been loaded the following screen will appear:
5. Press the continue button to proceed with installing GrandMaster Suite or select the Exit button if you wish to stop the process. Continuing with the installation calls up a dialog box which displays the product and version numbers.

![Install dialog box](image)

6. Select the OK button to continue. A dialog box will appear as follows:

![Install - directories dialog box](image)
7. Select the components to be installed and verify the location for the directories. There are 12 sub-directories of the GrandMaster Suite directory that will be created during the installation.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMSUITET</td>
<td>Root directory for the software. This directory normally contains the GRAND.INI file for the software.</td>
</tr>
<tr>
<td>GMSUITET\ADMIN</td>
<td>Directory containing the system administration data files.</td>
</tr>
<tr>
<td>GMSUITET\COMMON</td>
<td>Directory containing the common data files.</td>
</tr>
<tr>
<td>GMSUITET\PAYROLL</td>
<td>Directory containing the payroll base data files.</td>
</tr>
<tr>
<td>GMSUITET\HR</td>
<td>Directory containing the human resources data files.</td>
</tr>
<tr>
<td>GMSUITET\SCHEDULE</td>
<td>Directory containing the scheduling data files.</td>
</tr>
<tr>
<td>GMSUITET\TIMEKEEP</td>
<td>Directory containing the time keeping data files.</td>
</tr>
<tr>
<td>GMSUITET\ORGCHART</td>
<td>Directory containing the resource planning data files.</td>
</tr>
<tr>
<td>GMSUITET\EFT</td>
<td>Directory containing the electronic funds transfer data files.</td>
</tr>
<tr>
<td>GMSUITET\JOBCOST</td>
<td>Directory containing the labour distribution data files.</td>
</tr>
<tr>
<td>GMSUITET\BANKREC</td>
<td>Directory containing the bank reconciliation data files.</td>
</tr>
<tr>
<td>GMSUITET\RUNTIME</td>
<td>Directory containing the executable programs for GrandMaster Suite.</td>
</tr>
</tbody>
</table>

The directories shown above are created during the installation. Values are stored in the initialization parameters file “GRAND.INI”.

The system administrator should be consulted prior to altering this directory structure. If the initialization parameters file is changed, the user is responsible for moving any data files to the new directories. The system will create new empty directories if they are not available on the startup.

Press the Select ALL button or, if the GrandMaster Suite is to reside as a sub directory under another directory, insert a drive letter and major directory name in front of each of 12 GMSUITET directories.

**EXAMPLE:**
W:\APP\PAYROLL\GMSUITET
W:\APP\PAYROLL\GMSUITET\ADMIN

To re-direct the location from the local default Drive C, Select “Disk Space” button. A drop down list of available drives and space accessible from this computer will appear. Highlight the desired drive locations and tick the box to “Changes All Directories”. Click “OK”.

Once you have ensured that the GrandMaster Suite of all programs will be directed to the correct drive, you may proceed with the installation by pressing the “Install” button.
8. The Installation will proceed and the following screen will appear showing the progress.

<table>
<thead>
<tr>
<th>Install - progress</th>
</tr>
</thead>
<tbody>
<tr>
<td>GrandMaster Suite</td>
</tr>
<tr>
<td>Component: Base</td>
</tr>
<tr>
<td>Status: Unpacking</td>
</tr>
<tr>
<td>Elapsed Time: 00:00:04</td>
</tr>
<tr>
<td>0</td>
</tr>
<tr>
<td>100</td>
</tr>
<tr>
<td>Percent</td>
</tr>
</tbody>
</table>

Files:
Source: \epfinsts.exe
Target: C:\gmsuite\epfinsts.exe

On average, a CD-ROM install takes between one and two minutes.

9. Once the installation is complete, a message screen will appear advising you that the GrandMaster Suite installed successfully and that the CONFIG.SYS file has been altered to now include GrandMaster Suite. The message also advises you to shut down and re start your system to activate the changes. Select “OK”.

10. Select Exit from GrandMaster Suite Installation program.

11. Remove CD-ROM from CD-ROM drive and proceed with “Shut Down”.

Can-Pay Computer Software
Windows 95/NT Installation - (32 Bit) Nine Diskettes

In the event that you do not have an operating CD-ROM drive, you may request a GrandMaster Suite Windows 95/NT (32 Bit) distribution kit. This distribution kit consists of 9 diskettes for the program installation.

1. Insert Disk 1 into Diskette Drive

2. Under “My Computer” select Drive A to open. Double click on the INSTALL.EXE folder.
   OR

3. Under “Start,” “Programs” go to MSDOS Prompt.
   - CD \ [ENTER]
   - Type A: Install [ENTER]

4. When the necessary files have been loaded the following screen will appear:
5. Press the Continue button to proceed with installing Grandmaster Suite or select “Exit” button if you wish to stop the process. Continuing with the installation calls up a dialog box which displays the product and version number.

![Install dialog box](image)

6. Select the OK button to continue. A dialog box will appear as follows:

![Install directories dialog box](image)
7. Select the components to be installed and verify the location for the directories. There are 12 sub-directories of the GrandMaster Suite directory that will be created during the installation.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\GMSUITE</td>
<td>Root directory for the software. This directory normally contains the GRAND.INI file for the software.</td>
</tr>
<tr>
<td>\GMSUITE\ADMIN</td>
<td>Directory containing the system administration data files.</td>
</tr>
<tr>
<td>\GMSUITE\COMMON</td>
<td>Directory containing the common data files.</td>
</tr>
<tr>
<td>\GMSUITE\PAYROLL</td>
<td>Directory containing the payroll base data files.</td>
</tr>
<tr>
<td>\GMSUITE\HR</td>
<td>Directory containing the human resources data files.</td>
</tr>
<tr>
<td>\GMSUITE\SCHEDULE</td>
<td>Directory containing the scheduling data files.</td>
</tr>
<tr>
<td>\GMSUITE\TIMEKEEP</td>
<td>Directory containing the time keeping data files.</td>
</tr>
<tr>
<td>\GMSUITE\ORGCHART</td>
<td>Directory containing the resource planning data files.</td>
</tr>
<tr>
<td>\GMSUITE\EFT</td>
<td>Directory containing the electronic funds transfer data files.</td>
</tr>
<tr>
<td>\GMSUITE\JOBCLASS</td>
<td>Directory containing the labour distribution data files.</td>
</tr>
<tr>
<td>\GMSUITE\BANKREC</td>
<td>Directory containing the bank reconciliation data files.</td>
</tr>
<tr>
<td>\GMSUITE\RUNTIME</td>
<td>Directory containing the executable programs for GrandMaster Suite.</td>
</tr>
</tbody>
</table>

The directories shown above are created during the installation. Values are stored in the initialization parameters file “GRAND.INI”. The system administrator should be consulted prior to altering this directory structure. If the initialization parameters file is changed, the user is responsible for moving any data files to the new directories. The system will create new empty directories if they are not available on the startup.

Press the Select ALL button or, if the GrandMaster Suite is to reside as a sub directory under another directory, insert a drive letter and major directory name in from of each of 12 GMSUITE directories.

**EXAMPLE:**
W:\APPS\PAYROLL\GMSUITE
W:\APPS\PAYROLL\GMSUITE\ADMIN

To re-direct the location from the local default Drive C:, Select “Disk Space” button. A drop down list of available drives and space accessible from this computer will appear. Highlight the desired drive location and tick the box to “Changes All Directories”. Click “OK”.

Once you have ensured that the GrandMaster Suite of all programs will be directed to the correct drive, you may proceed with the installation by pressing the” Install” button.
8. The installation will proceed and the following screen will appear showing the progress.

![Install progress screen]

9. Once Disk 1 has been loaded, a prompt will appear to Insert disk 2.

![Insert disk prompt]

Continue
10. Place Disk 2 into the Diskette drive and select the Continue button. This process will be repeated for the remaining diskettes. Once all nine diskettes have been installed a message screen will appear advising you that the GrandMaster Suite installed successfully and that the CONFIG.SYS file has been altered to now include GrandMaster Suite. The message also advises you to shut down and restart your system to activate the changes. Select “OK”.

![Image showing installation instruction]

11. Select “Exit” from GrandMaster Suite installation program.

12. Remove the last diskette from the drive and proceed with “Shut Down”.
Installation - License Windows 95 and Windows NT

The GrandMaster Suite of Programs must be installed before installing your license disk. Your license will not be included on the CD-ROM but will be distributed by diskette for the foreseeable future.

It is important to request and install your license disk if you wish to implement the system for more than 20 employees. Without a license disk installed, GrandMaster Suite is considered a “Demo - For Evaluation” only.

1. The GrandMaster Suite License disk should be inserted into the diskette drive.

2. Under “My Computer” icon select Drive A. The contents of Drive A will be read and a Window will be presented on the screen listing the files on the disk. Double click on the INSTALL.Exe folder.

OR

3. Under “Start”, “Programs”, go to MSDOS Prompt. Do CD\ to change directories and type A: Install [ENTER]

4. A window will appear indicating that the GrandMaster Suite License installation program is loading files.

After the loading of the files is completed, the following dialog box will appear which allows the user to continue with the installation, or Exit (Cancel) from the install process.
5. Press the continue button to proceed with the installation. The following screen will appear asking if you wish to install this product.

![License installation screen](image)

**Install**

- **GrandMaster Suite License**
  - **Product number:** 0020-002
  - **Version:** 01.00.00
  - **Feature:** 0001

**Options**
- Update CONFIG.SYS/AUTOEXEC.BAT
- Overwrite files

**Install this product?**
- **OK**
- **Cancel**
- **Help**

6. Press “OK” to Install the License.

7. Select the components to be installed and verify the location for the directories. There are two directories that will be affected during the license installation.

![Component installation screen](image)

- **Select the components that you want to install:**
  - **GrandMaster Suite License**
    - **Bytes needed:** Unknown

- **Enter the directories where you want to install the components.**
  - **Installation directory:** C:\GMSUITE
  - **Executable Programs:** C:\GMSUITE\RUNTIME

Press the “Select All” button or insert major directory name and location in front of each of two GMSUITE directories.
To re-direct the drive location from the local default Drive C: Select “Disk Space” button. A drop down list of available drives and space accessible from this computer will appear. Highlight the desired drive location where GrandMaster Suite programs were previously installed and tick the box to “Change all Directories”. “Click OK”.

Ensure that the license disk is installed to the correct drive where GrandMaster Suite has been installed previously.
8. Select the Install button to install the license.

9. Once the license installation has been completed, a message screen will appear advising you that the GrandMaster Suite license installed successfully. The message also advises you to shut down and re-start your system, however, a full shut-down is not necessary at this stage.

10. Select Exit and return to your desktop.

11. Remove the disk from the diskette drive and store it in a safe place.
Windows 3.1 (16 Bit) Installation CD-Rom

1. Insert CD-ROM into CD-ROM drive

2. Under File Manager go to “Run” command. On the command line prompt type the drive letter of CD-ROM drive (\):\WINDOWS\INSTALL.EXE [ENTER]

3. When the necessary files have been loaded, the following screen will appear:

4. Press the Continue button to proceed with installing GrandMaster Suite or select the Exit button if you wish to discontinue the installation. Continuing with the installation calls up a dialog box which displays the product and version numbers.

```
Product number: 0020-001
Version: 01.00.00
Feature: 0001
Options:
  Update CONFIG.SYS

Install this product?
  OK  Cancel  Help
```
5. Select the OK Button to continue. A dialog box will appear as follows:

6. Select the components to be installed and verify the location for the directories. There are 12 sub-directories of the GrandMaster Suite directory that will be created during the installation.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\GMSUITE</td>
<td>Root directory for the software. This directory normally contains the GRAND.INI file for the software.</td>
</tr>
<tr>
<td>\GMSUITE\ADMIN</td>
<td>Directory containing the system administration data files.</td>
</tr>
<tr>
<td>\GMSUITE\COMMON</td>
<td>Directory containing the common data files.</td>
</tr>
<tr>
<td>\GMSUITE\PAYROLL</td>
<td>Directory containing the payroll base data files.</td>
</tr>
<tr>
<td>\GMSUITE\HR</td>
<td>Directory containing the human resources data files.</td>
</tr>
<tr>
<td>\GMSUITE\SCHEDULE</td>
<td>Directory containing the scheduling data files.</td>
</tr>
<tr>
<td>\GMSUITE\TIMEKEEP</td>
<td>Directory containing the time keeping data files.</td>
</tr>
<tr>
<td>\GMSUITE\ORGCHART</td>
<td>Directory containing the resource planning data files.</td>
</tr>
<tr>
<td>\GMSUITE\EFT</td>
<td>Directory containing the electronic funds transfer data files.</td>
</tr>
<tr>
<td>\GMSUITE\JOBCOST</td>
<td>Directory containing the labour distribution data files.</td>
</tr>
<tr>
<td>\GMSUITE\BANKREC</td>
<td>Directory containing the bank reconciliation data files.</td>
</tr>
<tr>
<td>\GMSUITE\RUNTIME</td>
<td>Directory containing the executable programs for GrandMaster Suite.</td>
</tr>
</tbody>
</table>

The directories shown above are created during the installation. Values are stored in the initialization parameters file “GRAND.INI”.

Can-Pay Computer Software 21
The system administrator should be consulted prior to altering this directory structure. If the initialization parameters file is changed, the user is responsible for moving any data files to the new directories. The system will create new empty directories if they are not available on the startup.

Press the Select ALL button or, if the GrandMaster Suite is to reside as a sub directory under another directory, insert a drive letter and major directory name in front of each of 12 GMSUITE directories.

**EXAMPLE:**

W:\APPS\PAYROLL\GMSUITE
W:\APPS\PAYROLL\GMSUITE\COMMON

To re-direct the location from the local default Drive C:, Select “Disk Space” button. A drop down list of available drives and space accessible from this computer will appear. Highlight the desired drive locations and tick the box to “Changes All Directories”. Click “OK”. Once you have ensured that the GrandMaster Suite of all programs will be directed to the correct drive, you may proceed with the installation by pressing the Install button.
7. The installation will proceed and the following screen will appear showing the progress:

![Installation Progress Screen]

8. Once the installation is complete, a message screen will appear advising you that the GrandMaster Suite installed successfully and that the CONFIG.SYS file has been altered to now include GrandMaster Suite. The message also advises you to shut down and restart your system to activate the changes. Select “OK”.

![Installation Message Screen]

9. Select Exit from GrandMaster Suite Installation program.

10. Remove CD-ROM from CD-ROM drive and proceed with “Shut Down”.
Windows 3.1 (16 Bit) Installation - Six Diskettes

In the event that you do not have an operating CD-ROM drive, you may request a GrandMaster Suite Windows (16 Bit) distribution kit. This distribution kit consists of 6 diskettes for the program installation.

1. Insert Disk 1 into the diskette drive

2. Under File Manger go to “Run” command. On the command line prompt type A: Install [ENTER]

3. When the necessary files have been loaded the following screen will appear:

![Installation screen](image)

4. Press the continue button to proceed with installing GrandMaster Suite or select the Cancel button if you wish to discontinue the installation. Proceeding with the installation calls up a dialog box which displays the product and version numbers.

![Product information](image)
5. Select the OK button to continue. A dialog box will appear as follows:

![Dialog box showing install directories]

6. Select the components to be installed and verify the location for the directories. There are 12 sub-directories of the GrandMaster Suite directory that will be created during the installation.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>\GMSUITE</code></td>
<td>Root directory for the software. This directory normally contains the GRAND.INI file for the software.</td>
</tr>
<tr>
<td><code>\GMSUITE\ADMIN</code></td>
<td>Directory containing the system administration data files.</td>
</tr>
<tr>
<td><code>\GMSUITE\COMMON</code></td>
<td>Directory containing the common data files.</td>
</tr>
<tr>
<td><code>\GMSUITE\PAYROLL</code></td>
<td>Directory containing the payroll base data files.</td>
</tr>
<tr>
<td><code>\GMSUITE\HR</code></td>
<td>Directory containing the human resources data files.</td>
</tr>
<tr>
<td><code>\GMSUITE\SCHEDULE</code></td>
<td>Directory containing the scheduling data files.</td>
</tr>
<tr>
<td><code>\GMSUITE\TIMEKEEP</code></td>
<td>Directory containing the time keeping data files.</td>
</tr>
<tr>
<td><code>\GMSUITE\ORGCHART</code></td>
<td>Directory containing the resource planning data files.</td>
</tr>
<tr>
<td><code>\GMSUITE\EFT</code></td>
<td>Directory containing the electronic funds transfer data files.</td>
</tr>
<tr>
<td><code>\GMSUITE\JOBCOST</code></td>
<td>Directory containing the labour distribution data files.</td>
</tr>
<tr>
<td><code>\GMSUITE\BANKREC</code></td>
<td>Directory containing the bank reconciliation data files.</td>
</tr>
<tr>
<td><code>\GMSUITE\RUNTIME</code></td>
<td>Directory containing the executable programs for GrandMaster Suite.</td>
</tr>
</tbody>
</table>

The directories shown above are created during the installation. Values are stored in the initialization parameters file “GRAND.INI”.
The system administrator should be consulted prior to altering this directory structure.
If the initialization parameters file is changed, the user is responsible for moving any
data files to the new directories. The system will create new empty directories if they
are not available on the startup.

Press the Select ALL button or, if the GrandMaster Suite is to reside as a sub directory
under another directory, insert a drive letter and major directory name in front of each
of 12 GMSUITE directories.

**EXAMPLE:**
W:\APP\PAYROLL\GMSUITE
W:\APP\PAYROLL\GMSUITE\ADMIN

To re-direct the drive location from the local default Drive C:, Select “Disk Space”
button. A drop down list of available drives and space accessible from this computer
will appear. Highlight the desired drive locations and tick the box to “Changes All
Directories”. Click “OK”.
Once you have ensured that the GrandMaster Suite of all programs will be directed to
the correct drive, you may proceed with the installation by pressing the Install button.

**7.** The installation will proceed and the following screen will appear showing the
progress.
8. Once Disk 1 has been loaded, a prompt will appear to insert disk 2.

![Insert disk dialog box]

9. Place disk 2 into the diskette drive and select the “Continue” button. This process will be repeated for the remaining diskettes. Once all six diskettes have been installed, a message will appear advising you that the GrandMaster Suite was installed successfully and that the CONFIG.SYS file has been altered to now include GrandMaster Suite. The message also advises you to shut down and restart your system to activate the changes. Select “OK”

![Installation and Maintenance dialog box]

10. Select “Exit” from GrandMaster Suite Installation program.

11. Remove last diskette from drive and proceed with “Shut Down”.
Installation-License-Windows 3.1

The GrandMaster Suite of programs must be installed before installing your license disk.
Your License will not be included on the CD-ROM but will be distributed by diskette for the foreseeable future.
It is important to request and install your license disk if you wish to implement the system for more than 20 employees. Without a license installed, GrandMaster Suite is considered a “Demo - For Evaluation” only.

1. Insert the license disk into the diskette drive.

2. Under File Manager, go to "RUN" command. On the command line prompt type A: Install [Enter]

3. A window will appear indicating that the GrandMaster Suite License installation program is loading files.

After the loading of the files is completed, the following dialog box will appear which allows the user to continue with the installation, or Exit (Cancel) from the install process.

---

Information Window

Welcome to GrandMaster Suite
The Following Windows will guide you through the installation of the GrandMaster License Software.
Thank you for selecting GrandMaster Suite
4. Press the “Continue” button to proceed with the installation. The following screen will appear asking if you wish to install this product.

![Install screen](image)

5. Press “OK” to install the license.
6. Select the components to be installed and verify the location for the directories that will be affected during the license installation.

![Install - directories](image)

Press the “Select All” Button or insert major directory name and location in front of each of two GMSuite directories.
To re-direct the drive location from the local default drive C:\; Select “Disk Space” button. A drop down list of available drives and space accessible from this computer will appear. Highlight the desired drive location where GrandMaster Suite programs were previously installed and tick the box to “Change All Directories “Click OK”.

Ensure that the License disk is installed to the correct drive where GrandMaster Suite had been installed previously.

7. Select the Install button to install the license.
8. Once the License installation has been completed, a message screen will appear advising you that the GrandMaster suite License installed successfully.
The message also advises you to shut down and re-start your system, however, a full shut down is not necessary at this stage.

9. Select Exit and return to your desktop.

10. Remove disk from diskette drive and store in a safe place.
1. Insert CD-ROM into CD-ROM drive.
2. Under Drives Icon, go to CD Drive and double click to open Drive, open the OS/2 folder and double click on the INSTALL.EXE program.
3. When the necessary files have been loaded the following screen will appear:

4. Press the continue button to proceed with installing GrandMaster Suite or select the cancel button if you wish to discontinue the installation. Continuing with the installation calls up a dialog box which displays the product and version numbers.
5. Select the OK button to continue. A dialog box will appear as follows:

![Dialog box](image)

6. Select the components to be installed and verify the location for the directories. There are 12 sub-directories of the GrandMaster Suite directory that will be created during the installation.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\GMSUITE</td>
<td>Root directory for the software. This directory normally contains the GRAND.INI file for the software.</td>
</tr>
<tr>
<td>\GMSUITE\ADMIN</td>
<td>Directory containing the system administration data files.</td>
</tr>
<tr>
<td>\GMSUITE\COMMON</td>
<td>Directory containing the common data files.</td>
</tr>
<tr>
<td>\GMSUITE\PAYROLL</td>
<td>Directory containing the payroll base data files.</td>
</tr>
<tr>
<td>\GMSUITE\HR</td>
<td>Directory containing the human resources data files.</td>
</tr>
<tr>
<td>\GMSUITE\SCHEDULE</td>
<td>Directory containing the scheduling data files.</td>
</tr>
<tr>
<td>\GMSUITE\TIMEKEEP</td>
<td>Directory containing the time keeping data files.</td>
</tr>
<tr>
<td>\GMSUITE\ORGCHART</td>
<td>Directory containing the resource planning data files.</td>
</tr>
<tr>
<td>\GMSUITE\EFT</td>
<td>Directory containing the electronic funds transfer data files.</td>
</tr>
<tr>
<td>\GMSUITE\JOBCOST</td>
<td>Directory containing the labour distribution data files.</td>
</tr>
<tr>
<td>\GMSUITE\BANKREC</td>
<td>Directory containing the bank reconciliation data files.</td>
</tr>
<tr>
<td>\GMSUITE\RUNTIME</td>
<td>Directory containing the executable programs for GrandMaster Suite.</td>
</tr>
</tbody>
</table>

The directories shown above are created during the installation. Values are stored in the initialization parameters file “GRAND.INI”.

Can-Pay Computer Software
The system administrator should be consulted prior to altering this directory structure. If the initialization parameters file is changed, the user is responsible for moving any data files to the new directories. The system will create new empty directories if they are not available on the startup.

Press the Select ALL button or if the GrandMaster Suite is to reside as a sub directory under another directory insert a drive letter and major directory name in front of each of 12 GMSUITE directories.

**EXAMPLE:**

W:\APPS\PAYROLL\GMSUITE
W:\APPS\PAYROLL\GMSUITE\COMMON

To re-direct the location from the local default Drive C:, Select “Disk Space” button. A drop down list of available drives and space accessible from this computer will appear. Highlight the desired drive locations and tick the box to Changes All Directories. Click “OK”.

Once you have ensured that the GrandMaster Suite of all programs will be directed to the correct drive, you may proceed with the installation by pressing the Install button.
7. The installation will proceed and the following screen will appear showing the progress:

![Install progress](image)

8. Once the installation is complete, a message screen will appear advising you that the GrandMaster Suite installed successfully and that the CONFIG.SYS file has been altered to now include GrandMaster Suite. The message also advises you to shut down and restart your system to activate the changes. Select “OK”.

![Installation and Maintenance](image)

9. Select Exit from GrandMaster Suite Installation program.

10. Retrieve CD-ROM from CD-ROM drive and proceed with “Shut Down”.
OS/2 Installation - Six Diskettes

In the event that you do not have an operating CD-ROM drive you may request a GrandMaster Suite OS/2 distribution kit. This distribution kit consists of 6 diskettes for the program installation.

1. Insert Disk 1 into the diskette drive
2. Open an OS/2 window and type A: Install [ENTER]
3. When the necessary files have been loaded the following screen will appear:

![Installation Screen]

4. Press the continue button to proceed with installing GrandMaster Suite or select the cancel button if you wish to discontinue the installation. Proceeding with the installation calls up a dialog box which displays the product and version numbers.

![Dialog Box]

Install            GrandMaster Suite
Product number:   0020-001
Version:          01.00.00
Feature:          0001

Options:
- Update CONFIG.SYS

Install this product?
[OK] [Cancel] [Help]
5. Select the OK button to continue. A dialog box will appear as follows:

![Image of installation dialog box]

6. Select the components to be installed and verify the location for the directories. There are 12 sub-directories of the GrandMaster Suite directory that will be created during the installation.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\GMSUITE</td>
<td>Root directory for the software. This directory normally contains the GRAND.INI file for the software.</td>
</tr>
<tr>
<td>\GMSUITE\ADMIN</td>
<td>Directory containing the system administration data files.</td>
</tr>
<tr>
<td>\GMSUITE\COMMON</td>
<td>Directory containing the common data files.</td>
</tr>
<tr>
<td>\GMSUITE\PAYROLL</td>
<td>Directory containing the payroll base data files.</td>
</tr>
<tr>
<td>\GMSUITE\HR</td>
<td>Directory containing the human resources data files.</td>
</tr>
<tr>
<td>\GMSUITE\SCHEDULE</td>
<td>Directory containing the scheduling data files.</td>
</tr>
<tr>
<td>\GMSUITE\TIMEKEEP</td>
<td>Directory containing the time keeping data files.</td>
</tr>
<tr>
<td>\GMSUITE\ORCHART</td>
<td>Directory containing the resource planning data files.</td>
</tr>
<tr>
<td>\GMSUITE\EFT</td>
<td>Directory containing the electronic funds transfer data files.</td>
</tr>
<tr>
<td>\GMSUITE\JOB\COST</td>
<td>Directory containing the labour distribution data files.</td>
</tr>
<tr>
<td>\GMSUITE\BANKREC</td>
<td>Directory containing the bank reconciliation data files.</td>
</tr>
<tr>
<td>\GMSUITE\RUNTIME</td>
<td>Directory containing the executable programs for GrandMaster Suite.</td>
</tr>
</tbody>
</table>

The directories shown above are created during the installation. Values are stored in the initialization parameters file “GRAND.INI”.

Can-Pay Computer Software
The system administrator should be consulted prior to altering this directory structure.

If the initialization parameters file is changed, the user is responsible for moving any data files to the new directories. The system will create new empty directories if they are not available on the startup.

Press the Select ALL button or if the GrandMaster Suite is to reside as a sub directory under another directory insert a drive letter and major directory name in front of each of 12 GMSUITE directories.

**EXAMPLE:**

W:\APPS\PAYROLL\GMSUITE
W:\APPS\PAYROLL\GMSUITE\ADMIN

To re-direct the drive location from the local default Drive C:, Select “Disk Space” button. A drop down list of available drives and space accessible from this computer will appear. Highlight the desired drive locations and tick the box to “Changes All Directories”. Click “OK”.

Once you have ensured that the GrandMaster Suite of all programs will be directed to the correct drive, you may proceed with the installation by pressing the Install button.

7. The installation will proceed and the following screen will appear showing the progress.

![Installation Progress](image-url)
8. Once Disk 1 has been loaded, a prompt will appear to insert Disk 2.

![Insert disk dialog box]

9. Place Disk 2 in the diskette drive and select the “Continue” button. This process will be repeated for the remaining diskettes. Once all six diskettes have been installed, a message will appear advising you that the GrandMaster Suite installed successfully and that the CONFIG.SYS file has been altered to now include GrandMaster Suite. The message also advises you to shut down and re-start your system to activate the changes. Select “OK”.

![Installation and Maintenance dialog box]

10. Select “Exit” from GrandMaster Suite Installation program.

11. Remove the last diskette from the drive and proceed with the “Shut Down”.
Installation - License - OS/2

The GrandMaster Suite of programs must be installed before installing your license disk.
Your license will not be included on the CD-ROM but will be distributed by diskette for the foreseeable future.
It is important to request and install your license disk if you wish to implement the system for more than 20 employees. Without a license installed, GrandMaster Suite is considered a "Demo-For Evaluation" only.

1. Insert License disk into diskette drive
2. Open an OS/2 window and Type A: INSTALL [ENTER]
3. A window will appear indicating that the GrandMaster Suite license installation program is loading files.

After the loading of the files is completed, the following dialog box will appear which allows the user to continue with the installation, or exit (Cancel) from the install process.
4. Press the “Continue” button to proceed with the installation. The following screen will appear asking if you wish to install this product.

![Installation Screen]

5. Press “OK” to install the license.

6. Select the components to be installed and verify the locations for the directories. There are two directories that will be affected during the license installation.

![Install - directories]

Press the Select All button or insert major directory name and location in front of each of the two GMSuite directories.

To re-direct the drive location from the local default drive C:\, Select “Disk Space” button. A drop down list of available drives and space accessible from this computer will appear. Highlight the desired drive location where GrandMaster Suite programs were previously installed and tick the box to “Change all Directories”. “Click OK”.

Ensure that the license disk is installed to the correct drive where GrandMaster Suite had been installed previously.

7. Select the Install button to install the license.
8. Once the license installation has been completed, a message screen will appear advising you that the GrandMaster Suite license installed successfully. The message also advises you to shut down and re-start your system, however, a full shut down is not required at this stage.

![Installation and Maintenance](image)

The requested components of GrandMaster Suite are successfully installed. Elapsed time was 00:05:34. Your CONFIG.SYS file has been modified. You must reboot your system to activate the changes.

OK

9. Select Exit and return to your desktop
10. Remove the disk from the diskette drive and store in a safe place.
Other Installation Considerations

Please review the following topics and recommendations in order to avoid any difficulties prior to installation of GrandMaster Suite.

- Installation of Software updates
- AUTOEXEC.BAT commands.
- Special note for Windows 95 and Windows NT install.
- Installation of 32 bit software
- DOS and Network file resources
- Windows 3.1 and Windows 95/NT
- Peer to Peer network setup for Windows 95 and Windows NT.
- GrandMaster Suite (32 Bit) considerations and GrandMaster II
- On-Line documentation
- Obtaining software updates - downloaded

Installation of Software Updates

GrandMaster Suite is an integrated set of personnel management software. As such it is an ever evolving product. There will be ongoing changes in functionality which will generate new updates to the product being sent to you periodically in addition to those changes to the payroll module necessitated by changes in tax regulations. These updates will be sent to you in your preferred format. Review the preceding installation techniques for your particular circumstances. Once the software has been installed, an update proceeds automatically to find the current installation and to update the programs. The only difference is that the update does not ask you to assign a drive location since it automatically detects current location. Once an update has completed successfully there is no requirement to do a full shut down of your system.
AUTOEXEC.BAT Commands

The path statement must contain the location of the GrandMaster Suite RUNTIME files.

```
PATH = C:\GMSUITE\RUNTIME;C:\DOS;C:\WINDOWS
```

A COBDIR statement must be present that points to the GRANDMASTER Suite RUNTIME files.

```
SET COBDIR = C:\GMSUITE\RUNTIME;
```

When GMII character mode software is installed the pointer to the GMSUITE RUNTIME programs must precede the pointer to the GMII programs.

```
SET COBDIR = C:\GMSUITE\RUNTIME;C:\GRNDMAST;
```

A COBHNF statement must be present that points to the Grandmaster Suite help files.

```
SET COBHNF = C:\GMSUITE\RUNTIME;
```

When GMII character mode software is installed the pointer to the GMSUITE help files must precede the pointer to the GMII help files.

```
SET COBHNF = C:\GMSUITE\RUNTIME; C:\GRNDMAST;
```

An incorrect COBDIR statement will usually result in the following screen display:

![Screenshot of error message](image)

Novell network login scripts may **overwrite** set commands in the AUTOEXEC.BAT file. This will cause a start up **error.**
Special Note for Windows 95 and Windows NT Install

This release contains a new set of runtime support modules for Windows 95 and Windows NT. A special procedure must be followed to install this update on Windows 95 and Windows NT workstation, if you have previously installed the Windows 3.1 (16 bit) product. This procedure is only required the FIRST time that the Windows/NT support modules are installed. Subsequent updates can be done by just updating the software without un-installing the existing software.

1. The existing software must be un-installed using the installation utility.
   - Start the GrandMaster Suite Installation Utility from the Start Menu
   - Select GrandMaster Suite from the list of products
   - Select the Delete action from the Action Menu choice
   - Select GrandMaster Suite in the Delete Action Window
   - Press the Delete button

The existing software will be removed from your system. After the software is removed the utility will request that a batch file -EPFIDEFI.BAT - be run from the root directory of your hard drive. This batch file completes the un-install procedure.

2. Insert the CD-ROM with the new software and install the update. Ensure that the correct drive is selected for the software installation.

3. Re-Start (re-boot) your workstation before using the software.
Installation of 32 bit Software

When the 32 bit software is installed without first uninstalling the 16 bit software the GrandMaster Suite program will not load. When the program is selected from the start menu or from a short cut the computer system will display a “wait” cursor for a fraction of a second, then the program will not start up.

Problem Resolution

Once the 32 bit software is installed, you cannot uninstall the 16 bit software using the installation utility. The only way to accomplish the uninstall is to do it manually by following the instructions given below.

1. Open the MSDOS prompt on Windows 95 or the command line on Windows NT and change to the drive where you have installed GrandMaster Suite.
   D: (if D is where the software is installed)

2. Copy the software license file to the \gmsuite directory
   COPY \GMSUITE\RUNTIME\LICENCE.LBR \GMSUITE

3. Delete the files in the \GMSUITE\RUNTIME directory (see NOTE below)
   DEL \GMSUITE\RUNTIME\*.*

4. Install the software from the CD-ROM or diskettes

5. Copy the software license file back to the \GMSUITE\RUNTIME directory
   COPY \GMSUITE\LICENCE.LBR \GMSUITE\RUNTIME

On some systems people have experienced problems with deleting files from the \GMSUITE\RUNTIME directory. If this happens, try re-booting your machine (shutdown and power off the machine and then power it back on). We are not sure why this occurs but it appears to be a problem with Windows 95 or the Network Software.

If you still cannot delete the files you can rename the runtime directory to a different name and create a new runtime directory by entering the following three commands:

1. CD\GMSUITE

2. REN RUNTIME OLDRUN

3. MD RUNTIME
DOS and Network File Resources

The GrandMaster Suite program may require access to a large number of file handles for some processing.

You should have your files setting in the CONFIG.SYS system file set to at least 128 when the program is installed on the local hard drive.

When you are using a network (such as) OS/2 Warp Server or Novell you should ensure that your workstation can access at least 128 network files. Consult your network OS documentation to determine how to do this.

When the number of files that can be accessed is insufficient, the software will display an error code of 9/14. If this occurs you must allow access to more file handles.

You may receive several different errors that are caused by the network problems. Please check with your network administrator for help in resolving these problems.

Windows 3.1 and Windows 95/NT

When a network contains a combination of Windows 3.1 and Windows 95/NT workstations you must have both the 16 bit and 32 bit windows versions of GrandMaster Suite available.

The Windows 3.1 workstations must have the COBDIR environment variable pointing to a directory that contains the 16 bit software. The default working directory for the workstation should be the directory that contains the 16 bit software.

The Windows 95/NT workstations must have the COBDIR environment variable pointing to a directory that contains the 32 bit software. The default working directory for the workstation should be the directory that contains the 32 bit software.

The 16 bit and 32 bit software cannot be installed in the same directory as they have routines with the same name that are actually different for the 16 bit and 32 bit software. If they are installed in the same directory they will not operate correctly.
Peer to Peer Network Setup - Windows 95 and Windows NT

In order to use GrandMaster Suite in a Peer to Peer network environment there are some steps to take before installing the software. These steps will establish a common shared drive letter for all workstations that will access the software.

Prime Workstation where GrandMaster Suite will be resident

1. Open the “My Computer” icon and open the “C:” drive
2. Create a folder that will be used to contain the GrandMaster Suite shared application
   - “Right Click” on a blank spot on the drive folder
   - From the pop-up menu select “New” then “Folder”
   - Type in the name for the folder “GMShare” (press enter after typing the name)
3. Share the folder for the GrandMaster Suite shared application
   - Right Click” on a the GMShare folder
   - From the pop-up menu select “Sharing”
   - On the Properties dialog box that appears
   - Check the “Shared” button
   - Type “GrandMaster Applications” in the comment field, Press the “Permissions” button and ensure that any users will access the applications are granted access
   - The default is “Everyone” with “Full Control”
   - Press the “OK” button on the Permissions dialog
   - Press “OK” on the Properties dialog
   - The folder icon will change to indicate that the folder is shared
On Windows NT
4. Open the “Network Neighborhood” icon and select the Prime Workstation
5. “Right Click” on the “GMSHare” folder and select “Map Drive”
   - Select a drive letter from the drop down list
   - Use the same drive letter on all workstations that access the share
   - Check the “Reconnect at Logon” choice
6. Install the GrandMaster Suite software to the drive letter set up in step 5.

On Windows 95
On Windows 95 Peer to Peer Network, you cannot always map a drive to a directory that is resident on the same machine. For Windows 95, use the following method instead of mapping a network drive letter.

Edit the AUTOEXEC.BAT file and insert the following command:
SUBST X C:\GMSHARE

Where X is the common drive letter selected for the GrandMaster suite software.

Other Workstations that will access GrandMaster Suite

1. Open the “Network Neighborhood” icon and select the Prime workstation
2. Right Click on the “GMSHare” folder and select “Map Drive”
   - Select a drive letter from the drop down list
   - Use the same drive letter on all workstations that access the share
   - Check the “Reconnect at Logon” choice
3. Install the GrandMaster Suite software to the drive letter set up in step 3.
GrandMaster Suite Windows and GM II

When both of these products are installed on the same workstation with either Windows 95 or Windows NT the set up of GM II must be changed to allow it to coexist with GrandMaster Suite.

GM II Setup Considerations

GM II is commonly installed using the GMII-WIN.BAT file to start the program. This batch file executes the program using XM (an extended memory manager). The program is running as a DOS application under the Windows 16 bit part of the operating system.

This can cause problems with the 16 bit GrandMaster Suite software if both applications are run at the same time. The XM program takes over the management of the 16 bit Windows memory space and can cause the execution to GrandMaster Suite and potentially other 16 bit Windows application programs - to fail.

The batch file used to execute GM II should be changed to contain the following commands: (assuming that GM II is installed on the C: drive)

SET SAVEDIR=%COBDIR%
SET COBDIR=C:\GRNDMAST
GRNDMWIN
SET COBDIR=%SAVEDIR%

These commands will cause GM II to run as a Windows text mode program. The GMII screens will be displayed in a window on the Windows 95/NT desktop rather than full screen.

The font size and other properties of the window can be set by clicking on the Windows system menu (top left corner of the window). The font size should be set to one that provides a comfortable display size. The save window settings on exit should be set, and the do not display application termination dialog should be set. These settings are available after GM II is started.

The GRNDMAST.INI file contains a number of settings for the physical port name for printers. These should be changed to the Form LPTn.DOS; where n is the port number. (Eg: LPT1.DOS rather than LPT1:). This will allow reports to print properly where the printer port is captured for routing to a network printer.

The AUTOEXEC file should not be used to set the COBDIR variable for use by GM II. The GrandMaster Suite program uses this setting and it should not be used for GMII.
GrandMaster Suite (32 bit) Considerations and GrandMaster II

When the GrandMaster Suite (32 bit) software is installed, the 32 bit runtime software is incompatible with the GrandMaster II programs.

Any setting of the COBDIR environment variable in the AUTOEXEC file must not include the GM II Installation directory (normally C:\GRNDMAST). This can cause the 32 bit GrandMaster Suite software to fail.

The COBDIR environment variable for the GM II programs must be set in a specific batch file used to start GM II. The commands in this file are discussed in the previous section.

If the GM II programs access the 32 bit runtime software, the programs will fail to execute. If you have a setup that includes the following AUTOEXEC environment variable setting:

```
SET COBDIR=C:\GMSUITE\RUNTIME;C:\GRNDMAST;
```

And the GM II program is started through a shortcut that contains the command C:\GRNDMAST\GRNDMWIN.EXE

The GM II program will fail to execute because the order of directories in the COBDIR environment variable will cause GMII to try running with the 32 bit runtime software.

If the order of the directories is changed so that the GM II directory precedes the GrandMaster Suite directory:

```
SET COBDIR=C:\GRNDMAST; C:\GMSUITE\RUNTIME;
```

The GrandMaster Suite program may fail to execute correctly.
On-Line Documentation

The \ACROBAT directory contains the auto-install programs for Acrobat Reader for Windows 3.1, Windows 95/NT and OS/2. These programs may be installed by executing the appropriate file.

AR02E30.EXE for OS/2
AR16E301.EXE for Windows 3.1
AR32E301.EXE for Windows 95

The PDF files in the \DOC directory may be copied to the hard drive if desired or they can be left on the CD-ROM. If they are left on the CD-ROM you will have to have the CD-ROM in your CD directory to view the documentation.

Obtaining Software Updates

Updates to the software can be downloaded from

Via FTP from: ftp://www.canpay.com
Via HTTP from: http://www.canpay.com/download/

Please consult the RELNOTES.TXT file located in the above locations for changes and corrections that may affect your operation of the GrandMaster Suite software. We update both the FTP site and the Web site with new features and fixes on a regular basis.
Problems locating the license file

The license file (Licence.LBR) must be located in the \GMSUITERUNTIME directory.
The COBDIR environment variable must point to the \GMSUITERUNTIME directory. 
1. Verify that the license file (LICENSE.LBR) is in the \gmsuite\runtime directory by using the dos DIR command (DIR \GMSUITERUNTIME\LICENSE.LBR).
2. Verify that the COBDIR environment is pointing to the correct location for the executable files. The DOS set command can be used to display the environment variable settings.

You may also edit the AUTOEXEC.BAT file to ensure that the SET COBDIR=D:\GMSUITERUNTIME command is present and points to the correct location.

If the command in the AUTOEXEC.BAT file is correct but the SET command shows a different value, this could result from settings in a Novell Login script or the equivalent for your network operating system.

If the command in the AUTOEXEC.BAT file is correct but the SET command shows a truncated value, this could result from insufficient environment space. The CONFIG.SYS file should contain a shell command to set the environment space.

For MS-DOS SHELL=C:\DOS\COMMAND.COM C:\DOS/E:4096 /P
For WIN95 SHELL=C:\WINDOWS\COMMAND.COM C:\WINDOWS/E:4096 /P
System Startup Processing

When the GrandMaster Suite program is started a window is displayed that contains the logo and a message that indicates the program is:

“VERIFYING INSTALLATION AND SETUP....”

This stage of the startup scans the system initialization parameters and verifies that all system data files are available and can be opened for processing.

If a file error is encountered at this stage a message box will be displayed that contains the name of the file and the associated error codes. Please refer to the file error codes list to determine the cause of the error and corrective action.

After the verification stage is complete the software license information is displayed and the user logon dialog box is displayed.

You will be warned when you are approaching the expiry date of your license. Your program will revert back to 20 employee maximum usage after this date. Be sure to contact Can-Pay prior to the expiry date for an update to your user license.
The Basic Elements of the GrandMaster System Manager

The following items appear throughout the GrandMaster System Manager:
- the logon dialog box
- the main screen
- the menu system
- the dialog boxes
- selection lists
- the on-line help system
- printer support
- printer setup

The Logon

The User ID field is used to enter your assigned user ID. If your User ID is not on file an error message will appear.

The installation process sets up a single User ID “SUPERVISOR” with no password. This ID should be used the first time the system is used after installation.

"Supervisor” has been set up with no password and unlimited access.
The Main Screen

The GrandMaster System Manager has nine modules:

- Administration
- Payroll
- Human Resources
- Schedule
- Labour Distribution
- Time Keeping
- Electronic Funds Transfer
- Bank Reconciliation
- Resource Planning
- Optional Applications

Space has been reserved for future development of an additional module.

**Selecting a Module**

To select a module move the mouse cursor over the appropriate button and select it by clicking the left mouse button once.

**Access Letters**

An alternate method of selecting items involves using access letters. The access letter is the character of the selection item that is underlined. To activate an item, press the access letter of the desired item while holding down the ALT key.

---

Example: To activate the **Payroll** module, press ALT+P.

---

The user may use only the access letters on the current window. The current window will have a solid colour bar on the top line.
# Main Screen Help

When the user selects the help menu the following screen will appear:

![Main Screen Help](image)

### Help
The Help menu option will bring up:

### Help Index
The Help Index will show you an index on the help system.

### Help Contents
The Help Contents will show you a table of contents on the help system.

### All About GrandMaster Suite
The All About GrandMaster Suite will show you a list of topics available to the user.

### License
The license option will show you your serial #, Validation #, your employee limit and the date your license expires.

### Version Number
The version number will show you the current version of GrandMaster Suite you are using.

### Release Notes
The Release notes option will bring up a screen of information on the changes made to the different modules.
The Menu System

When the user selects a menu item from a menu bar, a “drop-down” menu is displayed listing the options available.

An item can be selected by:

- arrowing up or down the menu list to the item and pressing the ENTER key
- pointing and clicking the left mouse button on the desired item
- using the ALT+ access character to select the item.

An arrow (→) to the right of an item indicates that selecting this item will give you further selections.
Dialog Boxes

Dialog boxes are “windows” in which information may be entered and edited by the user. The following is a sample of a dialog box:

The user can point and click on any field in the window to change or add information. To move from field-to-field using the keyboard press the TAB key or SHIFT +TAB to move backwards. To save and exit the screen, click on the OK button, or press the ALT +O. To abort all changes use the CANCEL button, or press the ALT +C.
Selection Lists

F8 (list) Positioning the cursor in a field and pressing the F8 key will bring up the corresponding selection list. Selection lists allow the user to select an item of information from a list. Usually, when the user makes an invalid entry in a dialog box, a selection list will appear, displaying the valid choices. The following is a sample of a selection list:

![Selection List Example]

**OK** The OK button confirms selection of the item under the selection bar.

**CANCEL** The CANCEL button exits the list without a choice.

**INSERT** The INSERT button allows the user to insert a new item in the list.

**UPDATE** The UPDATE button allows the user to alter the item under the selection bar.

**DELETE** The DELETE button allows the user to delete the item under the selection bar.

Double clicking on an item will make a selection and close the list. Single clicking on an item will highlight the item and then the desired button can be selected.

The insert, update, and delete buttons will only appear if the user is granted the privileges for these actions.
The On-Line Help System

GrandMaster Suite has a comprehensive on-line help system. This help system is activated by selecting the Help option on any menu bar or by pressing the help key (F1).

From any menu bar, the Help menu appears as follows:

HELP Main Menu

Regardless of the method used to access the HELP system the main menu will appear the same.

The help system dialog box will appear with the screen options across the bottom. There is a menu option bar at the top, including the help option on how to run help from the main menu bar. The screen will appear as follows:

The GrandMaster Administration Module gives the user access to all the functions on the administration module. Functions are accessed through the use of the menu bar on the screen. Choosing a menu item will start the functions attached to the menu item. File Menu contains functions that allow the user to update the user ID's and to set global preferences.

- Update User ID's - this menu choice will display the User ID selection screen for the selection of the User ID to update.
- Global Preferences - this menu choice will display the Global Preferences Screen that is used to update the overall system options.
- General Ledger Definition - this menu choice will display the General Ledger Definition Screen that is used to specify the general ledger code format.
- Initialization Parameters - this menu choice will display the screen used to update the startup initialization file settings.

Conversion setting functions that allow the user to access the programs.
Help Index

This option lists topics pertaining to the operation of System Administrator in alphabetical order. The user may select one of these topics to receive a more detailed description of the topic, relevant procedures, and available keystrokes.

Context-sensitive Help

F1 (help) When pressed, F1 will display a help screen specific to the active menu, dialog box, or selection list (context-sensitive). This help screen provides a description of each field in the active dialog box, and a description of each available keystroke.

Always try the context-sensitive help before referring to the User's Guide. Not only is the context-sensitive help faster and easier, it is also updated more frequently than the User's Guide.

To find out where a particular field is accessed, go to the index window and select the desired field name from the list.
The **Printer Setup** option allows the user to select a printer, select different fonts, point size, and select the orientation for the print job.

The following dialog box appears when the **Printer Setup** option is chosen:

If the gray circle to the left of the choice is highlighted, that indicates the choice is currently selected. Only one choice for each type of parameter may be selected at any time.

**Saving...**

The parameters are saved by pressing the **SAVE** button with the cursor or selecting the **Save** option in the File menu.

**Use...**

The parameters are used by pressing the **USE** button with the cursor or selecting the **Use** option in the File menu. This will be in effect only while you are currently logged on.

**Esc (exit)**

The ESC key, the CANCEL button, or the **Exit** option from the File menu will exit the screen without saving any changes.
The GrandMaster Suite accepts the printer setup from the operating system (Windows or OS/2). Prior to printing a report you should check or be aware of your “DEFAULT” printer settings. The wrong settings could cause your columns not to line up or lines to wrap (overflow to the next line).

The best font for report printing is a monospaced font such as Courier. Proportional fonts will distort the alignment of the columns in the reports.

Example:

| Monospaced font: (courier) | iiiiiiiiiiiiiii |
| Proportional font: (arial) | iiiiiiiiiii |

The user may set the preferred paper orientation and font through the printer setup dialog from the report menus. The user may also use this dialog to force the GrandMaster Suite to ask for printer and/or font selection each time a report is printed.

If you have problems with the printing of reports please ensure that you have the correct printer driver installed for your printer. The use of an incorrect or out-dated printer driver can cause problems with the appearance and content of the reports.
Back up your files

The GrandMaster Suite does not provide a built-in backup utility program. It is recommended that the user obtain and implement a reliable third-party backup system. The data files used by the GrandMaster Suite reside in the directories created during the installation process or in the alternate directories specified in the initialization parameter settings.

With the exception of the \GMSUTE\RUNTIME directory (which contains the executable programs) these directories MUST be backed up as a complete set and/or restored as a complete set.

Partial restoration of the data files WILL destroy the integrity of the system database. If the integrity of the database is not maintained you may find it necessary to re-enter ALL affected data.

We recommend that the data directories to be backed up daily and copies of the data be kept off site.

A disaster recovery plan should be in a place that will allow you to recover from catastrophic system failures.

The following data directories should be backed up to removable storage device:

- ADMIN Directory
- PAYROLL Directory and Sub Directories
- HR Directory
- SCHEDULE Directory
- TIMEKEEP Directory
- ORGCHART Directory
- JOBCOST Directory
- EFT Directory
- BANKREC Directory
- COMMON Directory

Any individual payroll subdirectories must be specifically included in the backup. GrandMaster Suite allows these files to be located anywhere on your local hard drives or network. These may not be included in the payroll directory and its subdirectories.
The Conversion menu in the Administration module contains functions that are used to convert files from previous Can-Pay payroll systems to the GrandMaster Suite payroll.

The functions available are:

- **Payroll Conversion (GrandMaster II)** - This function converts a GrandMaster II payroll to a GrandMaster Suite payroll.

- **Payroll Conversion (GrandMaster I)** - This function converts a GrandMaster I payroll into a GrandMaster Suite payroll.

- **Convert HomeCare Clients** - This function converts homecare clients data for the homecare module.
Payroll Conversion - GrandMaster II

What is converted?
The GrandMaster Suite does the conversion of GM II payrolls to the Suite data format. The conversion process conserves all settings for the Employer Information, Employee Information and the Earning, Deduction, and Accumulator types. The history contained in the GM II file for the current payroll year is stored in the Suite permanent history file.

What is NOT converted?
The conversion process does NOT allow you to generate a Journal Entry from the converted data. The GrandMaster Suite product will only produce Journal Entry reports and export files from pay calculations that are done by the Suite Payroll module. You must generate any outstanding journal entry reports and export files from the GM II software before converting to the GrandMaster Suite payroll.

Does this process affect my GM II data?
The conversion process has no effect on the GM II data files. The conversion only reads the GM II database. No data is changed in the GMII database.

Do I have to Clear my GM II payroll.
The conversion process will work on a payroll that has not been cleared after the last payroll calculation, BUT we strongly recommend that you clear the GM II payroll before converting the payroll. This will ensure that the GM II payroll is not re-calculated after the conversion with the possibility that confusion will occur because the converted payroll does not match the last GM II payroll calculation.

CAUTIONS
Each GMII payroll should be converted only once. A second conversion may duplicate the data from the GMII payroll in the history file if proper steps and precautions are not taken.
## Conversion Procedure Steps

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the GM II file location</td>
<td>The location of the GM II root directory must be set up in the Initialization Parameters settings in the Administration Module. These settings allow the conversion process to locate and list the GM II payrolls.</td>
</tr>
<tr>
<td>Create Suite Payroll</td>
<td>Create a GrandMaster Suite Payroll as a destination for conversion.</td>
</tr>
<tr>
<td>Select and convert the payrolls</td>
<td>The Administration module conversion menu is used to start the conversion process for each payroll.</td>
</tr>
<tr>
<td>Confirm the conversion processing</td>
<td>The Suite Payroll module is used to print the pay registers for the payroll converted. The Suite payroll can print registers from the history file so that the conversion of all pay run history in the GM II payroll can be verified.</td>
</tr>
<tr>
<td>Confirm the converted calculation parameters</td>
<td>Once the transfer of historical data has been verified by printing the pay register, all flag settings and deductions and accumulator calculation parameters should be verified.</td>
</tr>
</tbody>
</table>
Set the GM II file location

The Administration Module menu item FILE contains a menu choice INITIALIZATION PARAMETERS. This menu choice displays the initialization parameter settings and allows you to alter those settings. The tab for GM II contains a field where the location of the GM II root directory is entered.

The GMII directory field must contain the path for the GM II payroll. The default that is used for the GM II installation is C:\GRNDMAST. If you do not have GM II installed in the default location change this path to where you have installed GM II.

After entering the location of the GM II directory you must save the new parameter settings. The FILE menu has a SAVE choice that will save the initialization parameter settings. If the settings are not saved the conversion process will not be able to locate the GM II payroll files.
Creating the Suite payroll

The Select GrandMaster Payroll file screen shows a list of the existing Suite payrolls. The new payroll to receive the converted data can be created from the Suite payroll list screen.

Do not select a payroll that has existing data as a destination for the conversion. The conversion process will corrupt the existing data in the payroll permanent history file.

The Insert button is used to insert a new payroll for the conversion. The Payroll Name field is used to enter the code for the new payroll. The code name can be any combination of 10 characters, either alphabetic or numeric.
The GrandMaster Payroll File Update screen is displayed when a new payroll is being created.

![GrandMaster Payroll File Update](image)

This screen allows you to enter a description for the payroll being created and the path to the data files for the payroll. The path value is initially set to a default generated from the base payroll data directory and the code for the payroll. After you enter the description, pressing the OK button will create the new payroll. You will have to select the new payroll from the list screen after the payroll is created.
Select and convert the payrolls

The Conversion Process is accessed through the Administration Module CONVERSION menu. The menu choice PAYROLL CONVERSION (GM II) will start the conversion process. The Conversion Process displays a screen that lets you enter the name of the GM II payroll to convert and the name of the Suite payroll that will be the destination of the converted payroll data.
GM II Payroll

The field is used to enter the name of the payroll to convert. A list of the GM II payrolls can be obtained by pressing the F8 key when the field is selected.

The following gives a description of the Convert GM II payroll screen:

![GM II Payroll Selection Screen]

The GM II payroll selection screen is displayed when the list of payrolls is requested by pressing the F8 key. The payroll to convert can be selected by highlighting the payroll on the list and pressing the OK button.
**GMSUITE Payroll**

The field is used to enter the name of the Suite payroll that will be the destination for the converted data. A list of existing Suite payrolls can be obtained by selecting the List option in the File menu or by pressing the F8 key. The new payroll to receive the converted data can be created from the Suite payroll list screen.

We do not support combining payrolls through the conversion process.

**Pay Year**

This field pay year is used to enter the taxation year that is being converted. Normally, this field would contain the current year. However, the possibility to convert from a previous year if the data file is present or if the conversion is taking place during a transition period at the end of one taxation year where pay date is in the following tax year.

<table>
<thead>
<tr>
<th>Conversion Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Do Not Convert Summary History</strong></td>
</tr>
<tr>
<td>If you wish to convert only the payroll settings and employee base information but do not wish to convert the details from the historical data you may tick this box.</td>
</tr>
<tr>
<td><strong>Do Not Convert Detail History</strong></td>
</tr>
<tr>
<td>This box is ticked if you do not wish to convert the GMII overrides into transaction details for the payroll history.</td>
</tr>
<tr>
<td><strong>Do Not Convert Company Level Information</strong></td>
</tr>
<tr>
<td>This box is ticked if you do not wish to have the company/payroll level settings in GrandMaster Suite overridden by the GM2 company level settings. This could be used in the case where a GrandMaster Suite Payroll has been set up and tested with new earnings definitions or deductions parameters and you wish to preserve those settings.</td>
</tr>
<tr>
<td><strong>Match Employee Numbers on File</strong></td>
</tr>
<tr>
<td>This box MUST be ticked in the event that a re-conversion is being processed. If this box is not ticked, duplicated employee records will occur.</td>
</tr>
<tr>
<td><strong>Match Employee Pay Information</strong></td>
</tr>
<tr>
<td>This box may be ticked in the event that a re-conversion is being processed. This will prevent any employee level setups in the GrandMaster Suite Payroll from being overridden by the GM2 employee level settings.</td>
</tr>
<tr>
<td><strong>Do Not Convert Employee Settings</strong></td>
</tr>
<tr>
<td>This box may be ticked in the event that a re-conversion is being processed. This will prevent any employee level earnings setups and new definitions and parameters from being overridden by the previous GM2 Employee Level Settings.</td>
</tr>
</tbody>
</table>

If you choose the option “Do Not Convert Payroll Summary Records”, please consider the outcome which may result, if you convert the detail transactions but not the corresponding YTD Summary records. If you convert either transactions or history YTD records separately and not together, this may result in inconsistent payroll information.
Conversion Process

The PROCESS CONVERSION button is used to start the conversion processing. As the conversion progresses a Conversion Category Correspondence Screen will appear for certain selections to be made. The conversion program will convert all employee data fields that are optional in GrandMaster II. Some firms may have implemented only some or all of these. Therefore, the conversion program presents a list of these fields for specific inclusion in the conversion process. The following fields will be presented for conversion to the GrandMaster Suite Category fields:

<table>
<thead>
<tr>
<th>GM 2 Miscellaneous Page Fields</th>
<th>Corresponding GrandMaster Suite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department Code</td>
<td>Category 1</td>
</tr>
<tr>
<td>Account Number</td>
<td>Category 2</td>
</tr>
<tr>
<td>Sub-Account Number</td>
<td>Category 3</td>
</tr>
<tr>
<td>Position</td>
<td>Category 4</td>
</tr>
<tr>
<td>Revenue Canada Employment Type</td>
<td>Category 5</td>
</tr>
<tr>
<td>Optional Field A Contents</td>
<td>Category 6</td>
</tr>
<tr>
<td>Optional Field B Contents</td>
<td>Category 7</td>
</tr>
</tbody>
</table>

There are a number of sort options available in the Suite which will sort reports by category. By converting the fields in this way, reports such as the pay register can be sorted by Category 1 - Department Code as an Example. Upon completion of the conversion, this information can be found on each employee’s “Payroll Specific Information” Notebook.

Once the conversion category correspondence selections have been made the conversion will proceed to the next step.

A list of conversion pay periods will next be presented. The screen will present for confirmation or changing the pay period dates, run number and type of run. i.e.) Normal, Additional, Extra. If a pay period type must be changed, highlight the one to be changed and click once. An entry screen will be presented to accept the changes required. Click OK to save changes. Once the pay periods list has been reviewed click OK and the conversion can proceed.

The conversion process will display the employee names as the payroll is converted.

The payroll conversion process can be quite lengthy depending on the number of earnings, deductions, accumulators, and the volume of history to convert. If the conversion is taking place over a network, the network speed and throughput is also a factor.
Confirm the conversion processing

After the payroll is converted, we recommend that you print the pay register for the conversion pay run. This register should be compared to the GM II pay register to ensure that the payroll history converted correctly.

Reports can also be printed that show the Earning Types, Deduction Types, and Accumulator Types. The data in these reports can be compared to the GM II settings to ensure that the data was converted successfully.

The GMII earning table is converted to a named earning table in the new payroll. This table has a different format than the GM II format. All column and row pointers are changed so that they point to the equivalent data in the Suite earning table.

The GMII General Ledger account codes have not been converted in such a way that GrandMaster Suite can produce a Journal Entry without reinputting the General Ledger Codes into distribution tables. A blank distribution table will have been created for each different departments reference in GMII. It is recommended that you review your general ledger reporting requirements prior to setting up your new Journal Entry Structure. If each employee has a department code assignment, GrandMaster Suite has created a payroll category for that employee as well as assumed that employee’s assignment to a base distribution table of that same name or number.

Any additional information contained in the “Employee” Miscellaneous” page from GMII can be found in the Employee” Payroll Specific Information” Notebook under the Miscellaneous Tab.

Please review your Revenue Canada Employment Insurance Rate Assignments. Normally, full rate indicates part time employees or employees who do not receive qualifying company benefits. The company’s portion of employment insurance would then be charged at the “Full Rate” of 1.4 times the employee’s EI Deduction. Reduced rate normally applies to full-time employees or employees who receive Company benefits approved by Human Resources Canada qualifying the company for a reduced employment insurance rate.

<table>
<thead>
<tr>
<th>GrandMaster Suite</th>
<th>GMII</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Rate</td>
<td>Part Time</td>
</tr>
<tr>
<td>Reduced Rate</td>
<td>Full Time</td>
</tr>
</tbody>
</table>
Payroll Conversion - GrandMaster I

**What is converted?**
The GrandMaster Suite does the conversion of GM I payrolls to the Suite data format. The conversion process conserves all settings for the Employer Information, Employee Information and the Earning, Deduction, and Accumulator types.

**What is NOT converted?**
The conversion process does NOT allow you to generate a Journal Entry from the converted data. The GrandMaster Suite product will only produce Journal Entry reports and export files from pay calculations that are done by the Suite Payroll module. You must generate any outstanding journal entry reports and export files from the GM I software before converting to the GrandMaster Suite payroll.

**Does this process affect my GM I data?**
The conversion process has **no effect** on the GM I data files. The conversion only reads the GM I database. **No data is changed in the GM I database.**

**Do I have to Clear my GM I payroll.**
Yes. The conversion process will not work on a payroll that has not been cleared after the last payroll calculation.

**CAUTIONS**
It is recommended that each GM I payroll be converted only once. In the event of an problem, a second conversion can be attempted.
## Conversion Procedure Steps

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run the GM2PREP program</td>
<td>The GM2PREP program reads the payroll that you are going to convert and writes out a data file from the payroll that the Suite can read. This step is</td>
</tr>
<tr>
<td></td>
<td>required because the native file formats of the GM I payroll and the Suite Payroll are not compatible.</td>
</tr>
<tr>
<td>Create GrandMaster Suite Payroll</td>
<td>Create a GrandMaster Suite Payroll as a destination for the conversion.</td>
</tr>
<tr>
<td>Select and convert the payrolls</td>
<td>The Administration module conversion menu is used to start the conversion process for each payroll.</td>
</tr>
<tr>
<td>Confirm the conversion process</td>
<td>The Suite Payroll module is used to print the pay registers for the payroll converted. The Suite payroll can print registers from the history file so that</td>
</tr>
<tr>
<td></td>
<td>the conversion of all pay run history in the GM I payroll can be verified.</td>
</tr>
<tr>
<td>Confirm the converted calculation</td>
<td>Once the transfer of historical data has been verified by printing the pay registers, all flag settings and deductions and accumulator calculation</td>
</tr>
<tr>
<td></td>
<td>parameters should be verified.</td>
</tr>
</tbody>
</table>
Run the GM2PREP Program

The GM2PREP program is a stand-alone program that reads the GM1 payroll master and writes out an interim file that can be read by the GrandMaster Suite program. The GM2Prep program is distributed with the Suite and is located in the GMSuite Runtime directory during installation.

Your first step will be to copy the GM2Prep program from GrandMaster Suite to your CanPay directory where your GM1 payroll files are located. The entire GM2Prep procedure must be done from a DOS prompt.

If your CanPay files are resident on a different physical machine running DOS only the following procedure will apply for preparing your GM1 files for conversion to GrandMaster Suite.

1. On the computer where GrandMaster Suite has been installed, insert a diskette into diskette drive A:

2. From a DOS prompt Type:
COPY C:\GMSUITE\RUNTIME\GM2PREP.EXE A:

3. A message should appear advising you that 1 file has been copied.

4. Remove the diskette and label with contents and date.

5. On the DOS computer where CanPay GM1 files are resident insert GM2PREP.EXE diskette into Drive A.

6. From a DOS prompt Type:
COPY A:\*.* C:\CANPAY

7. A message should appear advising you that 1 file has been copied.

8. Remove diskette and store.

Use the correct drive letter where Canpay GM1 is installed to copy to if it is different than C:

9. On the DOS Computer where CanPay GM1 files are resident insert a blank diskette into Drive A.

10. From a DOS prompt go to the CanPay directory
CD\Canpay

11. Run the GM2Prep program type:
GM2Prep [ENTER]
12. The Program will display a screen that allows you to enter the name of the payroll to convert. This is the normal name that you use for your payroll.

13. After requesting the name of the payroll to convert the program will ask for the file-name to use for the conversion data file. Make a note of this file name because you will need it later.

14. Type A:\Filename This will over type the contents pre-assigned in this field.

15. This will take very little time to process

16. If you have more than one payroll to convert leave diskette in Drive A, use your F3 key to repeat the command and press enter.

17. Repeat steps 12 to 15 inclusive.

18. When all payrolls have been copied to the diskette. Remove the diskette and label and date it appropriately.

19. Type Exit [ENTER]

20. Exit DOS

21. The diskette you have created here will be inserted in the diskette drive of the computer where GrandMaster Suite is installed and the conversion will be run referencing the drive location.

If your CanPay files are resident on the same physical computer that GrandMaster Suite has been installed on the following procedures will apply. It is extremely important to note the correct drive location of both programs in completing these steps.

1. From a DOS prompt type:
   Copy ?:\GMSUITEx\RUNTIME\GM2PREP ?:\CANPAY where question mark represents the drive letter locations of both programs. You would replace question mark with the appropriate drive letter.

2. A message should appear advising you that 1 file has been copied.

3. You must now run the GM2Prep program from the CanPay directory on whatever drive. ?: [ENTER] CD\CANPAY

4. Type : GM2PREP
5. The program will display a screen that allows you to enter the name of the payroll to convert. This is the normal name that you use for your payroll.

6. After requesting the name of the payroll to convert, the program will ask for the destination drive and file name to use for the conversion data file. The name used here should be noted since it will be required later.

7. Type ?\File Name This will overtype the contents preassigned in this field.

8. This takes very little time to process

9. If you have more than one payroll to convert, use your F3 key to repeat the command and press enter.

10. Repeat steps 5 to 8 inclusive

11. When complete, type: exit [ENTER]

12. Exit DOS
Creating the Suite payroll

The Select GrandMaster Payroll file screen shows a list of the existing Suite payrolls. The new payroll to receive the converted data can be created from the Suite payroll list screen.

Do not select a payroll that has existing data as a destination for the conversion. The conversion process will corrupt the existing data in the payroll permanent history file.

The Insert button is used to insert a new payroll for the conversion. The Payroll Name field is used to enter the code for the new payroll. The code name can be any combination of 10 characters, either alphabetic or numeric.
The GrandMaster Payroll File Update screen is displayed when a new payroll is being created.

![GrandMaster Payroll File Update Screen]

This screen allows you to enter a description for the payroll being created and the path to the data files for the payroll. The path value is initially set to a default generated from the base payroll data directory and the code for the payroll.

After you enter the description, pressing the OK button will create the new payroll. You will have to select the new payroll from the list screen after the payroll is created.
Select and convert the payrolls

The Conversion Process is accessed through the Administration Module CONVERSION menu. The menu choice PAYROLL CONVERSION (GMI) will start the conversion process.

The Conversion Process displays a screen that lets you enter the name and path of the GMI payroll data file that was output from the GM2PREP program and the name of the Suite payroll that will be the destination of the converted payroll data.

The screen offers two options for processing the file conversion. The Do Not Convert Transactions is ticked if you do not want to convert the GMI transactions for the payroll history.

If a previous conversion ran into some difficulty a reconversion can be processed only if the match employee numbers is checked!

GM2PREP Output File

The field GM2PREP File is used to enter the name of the data file for the payroll to convert and the drive location if necessary such as in the case where you created a separate diskette from GM2PREP.

Suite Payroll

The field Suite Payroll is used to enter the name of the Suite payroll that will be the destination for the converted data. A list of the existing Suite payrolls can be obtained by selecting the List option in the File menu or by pressing the F8 key. The new payroll to receive the converted data can be created from the Suite payroll list screen.

We do not support combining payrolls through the conversion process.
Conversion Process

The PROCESS CONVERSION button is used to start the conversion processing. As the conversion progresses a Conversion Category Correspondence Screen will appear for certain selections to be made. The conversion program will convert the employee year to date pay data and most of the employee personal data. There are however, some data fields that are optional in GrandMaster I. Some firms may have implemented only some or all of these. Therefore, the conversion program presents a list of these fields for specific inclusion in the conversion process. The following field will be presented for conversion to the GrandMaster Suite category fields.

<table>
<thead>
<tr>
<th>GM 1 Employee Record Fields</th>
<th>Corresponding GrandMaster Suite Categories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>Category 1</td>
</tr>
<tr>
<td>Account</td>
<td>Category 2</td>
</tr>
<tr>
<td>Position</td>
<td>Category 3</td>
</tr>
<tr>
<td>Revenue Canada Employment</td>
<td>Category 4</td>
</tr>
<tr>
<td>Type</td>
<td>Category 5</td>
</tr>
<tr>
<td>Company Code</td>
<td></td>
</tr>
</tbody>
</table>

It is suggested that the fields be selected by using the up and down arrows and highlighting in sequential order. The department code from GrandMaster I would be converted to the Grand Master Suite Category 1. There are a number of sort options available in the Suite which will sort reports by category. By converting the fields this way, reports such as the pay register can be sorted by Category 1 - Department Code as an example. Upon completion of the conversion, this information can be found on each employee's "Payroll Specific Information" notebook.

Once the conversion category correspondence selections have been made the conversion will proceed to the next step.

A list of conversion pay periods will next be presented. The screen will present for confirmation or changing the pay period dates, run number and type of run, i.e.: Normal, Additional, Extra. If a pay period or type must be changed, highlight the one to be changed and click once. An entry screen will be presented to insert the changes required. Click OK to save the changes. Once the pay period list has been reviewed click OK and the conversion can proceed.

Since GrandMaster I does not store any run history except the last one, the Suite extrapolates the dates from the last run dates and the pay frequency but it assumes all runs are normal. If there have been additional or extra pay runs, these will not be reflected in the pay period correctly and the run numbers may be dated back into the previous year. The pay period list must be carefully reviewed and amended where necessary. The conversion process will display the employee names as the payroll is converted.
The payroll conversion process can be quite lengthy depending on the number of earnings, deductions, accumulators, and the volume of history to convert. If conversion is taking place over a network, the network speed and throughput is also a factor. If the conversion is reading the files to be converted from the diskette drive, this may be somewhat slower.

**Confirm the conversion processing**

After the payroll is converted, we recommend that you print the pay register for the conversion pay run. This register should be compared to the GM1 pay register to ensure that the payroll history converted correctly. Reports can also be printed that show the Earning Types, Deduction Types, and Accumulator Types. The data in these reports can be compared to the GM1 settings to ensure that the data was converted successfully.

In some cases it has been noted that rates expressed as percentages in GM1 do not transfer correctly to GrandMaster Suite due to a different processing technique in both programs. The numerals will be correct but the placement of the decimal point may not be. Please carefully review all deduction parameters and make any adjustment prior to running your first calculation.

The GM1 earning table is converted to a named earning table in the new payroll.

The GM1 General Ledger Account codes have not been converted in such a way that GrandMaster Suite can produce a Journal Entry without inputting the General Ledger codes into the distribution tables. A blank distribution table will have been created for each different department reference in GM1. It is recommended that you review your General Ledger reporting requirements prior to setting up your new Journal Entry structure. If each employee had a department code assignment, GrandMaster Suite has created a payroll category for that employee as well as assumed that employee’s assignment to a base distribution table of that same name or number.

Please review your Revenue Canada Employment insurance rate assignments. Normally, full rate applies to part-time employees or employees who do not receive company benefits. The company’s portion of employment insurance would then be charged at the “Full Rate” of 1.4 times the Employee’s Deduction for E.I. Reduced rate normally applies to full time employees or employees who receive company benefits approved by Human Resources Canada qualifying the company for a reduced Employment Insurance portion rate.

<table>
<thead>
<tr>
<th>GrandMaster Suite</th>
<th>GM1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Rate</td>
<td>Partime</td>
</tr>
<tr>
<td>Reduced Rate</td>
<td>FullTime</td>
</tr>
</tbody>
</table>
Convert Homecare Clients

The **Convert Homecare Clients** option is used to load data from a comma delimited ASCII file (CSV format) into the homecare client database.

The screen presented contains the names of the data fields that can be converted and a field that represents the fields position in the input data record.

A position number must be entered for any data field that will be updated to the homecare client database. The position number is the sequential position that the field occupies in the import file. (eg) If the field is 5th in the list of fields in the file, it’s position number is 5.

The dialog box will appear as follows:

![Homecare CCS Client Conversion](image)

- **Input File**: \agmsuite\import\client.txt

- **Fields**
  - **Account**: 1
  - **Last Name**: 3
  - **First Name**: 4
  - **Address 1**: 5
  - **Address 2**: 6
  - **Province**: SK
  - **Province Set**: 7
  - **Postal**: 8
  - **Phone 1**: 9
  - **Phone 2**: 10
  - **Phone 3**: 11
  - **Sex**: 12
  - **Birth Date**: 13
  - **Medicare**: 14
  - **Area**: 15
  - **Contact**: 16
  - **Relation**: 17
  - **Phys 1**: 18
  - **Phys Phone1**: 19
  - **Phys 2**: 20
  - **Phys Phone2**: 21
  - **Extra1**: 22
  - **Extra 2**: 23

- **Buttons**: Process, Cancel
The data fields contained in this screen are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input File</td>
<td>This field contains the name and location of the import file.</td>
</tr>
<tr>
<td>Account</td>
<td>This field is for entering a position number for account number field.</td>
</tr>
<tr>
<td>Last Name</td>
<td>This field is for entering a position number for last name field.</td>
</tr>
<tr>
<td>First Name</td>
<td>This field is for entering a position number for first name field.</td>
</tr>
<tr>
<td>Address 1</td>
<td>This field is for entering a position number for the address line one field.</td>
</tr>
<tr>
<td>Address 2</td>
<td>This field is for entering a position number for the address line two field.</td>
</tr>
<tr>
<td>City</td>
<td>This field is for entering a position number for the city field.</td>
</tr>
<tr>
<td>Province</td>
<td>This field is for entering a position number for provinces field.</td>
</tr>
<tr>
<td>Province Set</td>
<td>This field is for the preset province code.</td>
</tr>
<tr>
<td>Postal</td>
<td>This field is for entering a position number for postal code field.</td>
</tr>
<tr>
<td>Phone 1</td>
<td>This field is for entering a position number for phone number field.</td>
</tr>
<tr>
<td>Phone 2</td>
<td>This field is for entering a position number for additional phone numbers field.</td>
</tr>
<tr>
<td>Sex</td>
<td>This field is for entering a position number for the individuals sex code field.</td>
</tr>
<tr>
<td>Birth Date</td>
<td>This field is for entering a position number for birth date field.</td>
</tr>
<tr>
<td>Medicare</td>
<td>This field is for entering a position number for medicare number field.</td>
</tr>
<tr>
<td>Area</td>
<td>This field is for entering a position number for area code field.</td>
</tr>
</tbody>
</table>
New Customers of GrandMaster Suite Payroll

We recognize that there is a great deal of data entry work which must be done in order to implement the GrandMaster Suite payroll when you are not converting from one of our own Canay Computer Software Ltd's other payroll products. We have provided some functions that will permit the import of employees' personal information and their current year to date balances.

These functions are not available in the Administration Module but rather can be accessed from the Payroll Module directly.
We refer the user to Chapter 3 - Data of our Payroll Manual.

In order to initiate these import functions it will be necessary for the user to complete the Company/Payroll level setups. Effectively, a payroll should be as completely set up as possible in order to create a destination for the data to be imported to. We strongly recommend spending the time to set up employee templates. A template can be used to set up each employees' set of predefined earnings, deductions and accumulators at the time of adding an employee to a payroll. This will save on the set up time.

Import Employee Names:

1. Create an Export file from your current system, usually with a file extension of .txt. Note the drive location and exact file name.
2. Go to GrandMaster Suite Payroll Module
3. Under File; Select your payroll that you are importing to
4. Under Data; Go to Import/Export functions
5. Select Import Employee Names
6. Insert the drive location, if necessary, and your Export directory and File name and extension.
7. Indicate whether it is a fixed length or comma delimited file that has been exported.
8. Indicate the Date format in the Export file
9. GrandMaster Suite is a date based system and uses a 4 digit year format. Other systems however may not store the year as 4 digits but rather 2 digits. It will be necessary to indicate the century that the Import applies to by completing the year option field. This function indicates to the system the conversion of the two digit years to four digit years. The program will determine the first two digits for the four digit year using a formula expressed in the "Year Option" box. When the incoming year is greater than or equal to the value in
the “If Year>=” Field the first two digits of the four digit year will be the value in the “Century is” field.
When the incoming year is less than the value in the "If Year>=" Field the first two digits of the four digit year will be set to the value in the "Century is" field plus 1. It is necessary to complete this function in order for birth dates and initial hire dates to be translated correctly.

10. Select either comma delimited tab or fixed length record tab of notebook and indicate the record position or location of field to import.

11. Once you are satisfied that you have completed the notebook, ensure that your default printer is "ON" and "ONLINE". A report of the import file will be automatically generated.

12. Press Process

13. A file of Employee's names and Personal information has been created in the Suite. However, there is a further step to insert these people into the GrandMaster Suite payroll. Please refer to "Add an Employee" function in the "Payroll" or "Human Resources" manuals.

14. Once your employees have been added to the GrandMaster Suite Payroll, you may then proceed to import their year to date history data from your current system.

15. Create an Export file from your current system. Note the drive location and exact file name.

16. Go to GrandMaster Suite Payroll Module

17. Under File, Select the Payroll that you are importing to.

18. Under Data, go to Import/Export functions

19. Select "Import Pay Adjustments"

20. Please refer to the "Payroll" manual for further instructions.

21. Once your Year to Dates have been successfully imported we suggest that you print a payroll register to confirm your imports are complete. See "Payroll" Manual section on "Reports".
MANAGING ADMINISTRATION

The Administration Module allows the users to configure the GrandMaster Suite and assign privileges to the users. This module should only be used by a supervisor who has knowledge of the computer system configuration and network.

The GrandMaster Suite is a multi-user system with the applications all linked together to provide common access to the information. The modules and files of the GrandMaster Suite can be spread about the network and must be controlled by a system administrator.

The system administrator using the Administration module can:

1. Change system configuration
2. Add, change, or delete users
3. Convert GrandMaster I, and GrandMaster II payrolls to the GrandMaster Suite payroll
4. Set overall operating parameters
5. Run special utility programs
Main Administration Module

The Administration main menu provides access to define the user ID's, global preferences, general ledger codes, and initialization parameters. This menu also gives the user access to perform conversions, and start up specialized utility functions (only needed by some users).
When the user selects the Administration file menu the following screen will appear:

<table>
<thead>
<tr>
<th>Grandmaster Administration</th>
<th>File</th>
<th>Conversion</th>
<th>Utilities</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update User ID's</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Global Preferences</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General Ledger Definition</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initialization Parameters</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>exit</td>
<td></td>
<td>Esc</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The File menu offers the following functions to the user:

- Creating user ID's, setting up passwords, and defining the privileges for each user ID
- Setting up global preferences which apply to all users
- Defining all general ledger codes
- Entering the data directory for the data files
- Modifying the initialization parameters for the Suite
Update User ID's

The **Update User ID's** option allows the user to create and/or update the user ID list. When the user chooses the **Update User ID's** option a dialog box appears as follows:

![User ID Selection Dialog Box]

**F8 (list)**  
The **F8** key or the **List** option will display a list of the existing user ID's and names.

```
<table>
<thead>
<tr>
<th>KEY</th>
<th>User ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bev</td>
<td>Bev Olson</td>
</tr>
<tr>
<td>Lorne</td>
<td>Lorne Sunley</td>
</tr>
<tr>
<td>LVLE</td>
<td>Scamnell</td>
</tr>
<tr>
<td>SUPERVISOR</td>
<td>System Generated User ID</td>
</tr>
</tbody>
</table>
```

*The list will only contain all the ID's and names if the User ID field is blank when the **List** option is selected. Otherwise, only the names of the ID specified in the User ID field will appear in the list that is created. Select a name from the list by double clicking with the mouse.*

Or, to add a new user ID (for creating or adding a new name to an existing list) type the ID name in the User ID field, and press the **OK** button.
This action will bring up a new dialog box:

The User Name tab screen is used to enter the user's name and to set the user's password.

The user is to enter the name of the person corresponding to the ID. The time of the last logon will appear at the bottom.

The following table gives a description of the screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This field is used to enter the name of the user</td>
</tr>
<tr>
<td>Last Logon</td>
<td>This field displays the last time the user logon.</td>
</tr>
<tr>
<td>Set Password</td>
<td>This field is used to set the password of the user</td>
</tr>
</tbody>
</table>

Saving... When the name has been entered use the SAVE button or the Save option in the File menu.

Esc (cancel) The CANCEL button, the Exit option in the File menu, or the ESC key is used to exit the screen without saving any changes made within the screen.

Select All The SELECT ALL button will turn on all the privileges available on all the user privilege screens within the notebook.

The individual notebook pages are used to update privilege settings for each specific module.
Setting a Password

Use the Set Password button to set a password. The following dialog box will appear when this button is selected:

<table>
<thead>
<tr>
<th>Password:</th>
<th>Password:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm:</td>
<td>Confirm:</td>
</tr>
</tbody>
</table>

The password and confirmation of the password will not be visible when it is being entered. Please note whether upper or lower case is used at the time of establishing a password. It will be necessary to enter the password exactly as saved.

Saving... The OK button will save the password and exit from the screen.

Esc (exit) The ESC key or the CANCEL button are used to exit from the screen without saving any changes.
Restricting Access

The Module tab opens the page of the notebook that is used to set which modules are accessible by the different users. The Module tab screen appears as follows:

![Module Tab Screen]

To set user privileges:
1. Select the module(s) by clicking once on the name or box of the desired module(s) with the mouse. A check mark will appear in the box of the selected module.
2. Use the tabs to select any module(s) previously selected in step one. This will bring up the screen(s) in which the parameters are set within the appropriate module(s), for the user.

Selected modules (those with check marks) will be accessible to the user.

Saving... The SAVE button or the Save option in the File menu will exit the screen after saving any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen without saving any changes.

Select All The SELECT ALL button does not turn on all the modules to be accessed. It will be necessary to specifically designate which modules can be accessed.
Common Data Privilege Settings
The Common tab screen is used to update commonly used privileges for the user. The common tab screen appears as follows:

The following table gives a description of the screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>This group of check boxes determines if the user can add, change, or delete employee's in the database.</td>
</tr>
<tr>
<td>Calendar</td>
<td>This group of check boxes determines if the user can add, change, or delete calendar items in the database.</td>
</tr>
<tr>
<td>Object</td>
<td>This group of check boxes determines if the user can add, change, or delete objects in the database.</td>
</tr>
<tr>
<td>G/L Codes</td>
<td>This group of check boxes determines if the user can add, change, or delete G/L codes in the database.</td>
</tr>
<tr>
<td>Position</td>
<td>This group of check boxes determines if the user can add, change, or delete positions in the database.</td>
</tr>
<tr>
<td>Object Group</td>
<td>This group of check boxes determines if the user can add, change, or delete object groups in the database.</td>
</tr>
<tr>
<td>Leaves</td>
<td>This group of check boxes determines if the user can add, change, or delete leave items in the database.</td>
</tr>
<tr>
<td><strong>Saving...</strong></td>
<td>The SAVE button or the <strong>Save</strong> option in the File menu will exit the screen after saving any changed data.</td>
</tr>
<tr>
<td><strong>Esc (exit)</strong></td>
<td>The ESC key, CANCEL button, or <strong>Exit</strong> option from the file menu will exit the screen without saving any changes.</td>
</tr>
<tr>
<td><strong>All</strong></td>
<td>The <strong>ALL</strong> button will turn on all the options available on the current user privilege screen.</td>
</tr>
<tr>
<td><strong>Select All</strong></td>
<td>The <strong>SELECT ALL</strong> button will turn on all the privileges available on all the user privilege screens within the notebook.</td>
</tr>
</tbody>
</table>
Payroll Data Privilege Settings
The Payroll tab screen is used to update payroll privileges for the user. The payroll screen appears as follows:

The following tables gives a description of the screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payroll Employee</td>
<td>This group of check boxes determines if the user can add, change, or delete payroll employee's in the database.</td>
</tr>
<tr>
<td>Deductions</td>
<td>This group of check boxes determines if the user can add, change, or delete deductions in the database.</td>
</tr>
<tr>
<td>Payrolls</td>
<td>This group of check boxes determines if the user can add, change, or delete payrolls in the database.</td>
</tr>
<tr>
<td>Earnings</td>
<td>This group of check boxes determines if the user can add, change, or delete earnings in the database.</td>
</tr>
<tr>
<td>Accumulators</td>
<td>This group of check boxes determines if the user can add, change, or delete accumulators in the database.</td>
</tr>
<tr>
<td>Audit Trail</td>
<td>This option determines if the user can use the audit trail function.</td>
</tr>
<tr>
<td>Calculate Payroll</td>
<td>This option determines if the user can calculate payroll.</td>
</tr>
<tr>
<td>Change Company</td>
<td>This option determines if the user can change company information.</td>
</tr>
<tr>
<td>View Payroll Data</td>
<td>This option determines if the user can view payroll data.</td>
</tr>
<tr>
<td>View Pay Rates</td>
<td>This option determines if the user can view pay rates.</td>
</tr>
</tbody>
</table>

Saving... The SAVE button or the Save option in the File menu will exit the screen after saving any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen without saving any changes.
<table>
<thead>
<tr>
<th>All</th>
<th>The ALL button will turn on all the options available on the current user privilege screen.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select All</td>
<td>The SELECT ALL button will turn on all the privileges available on all the user privilege screens within the notebook.</td>
</tr>
</tbody>
</table>
H/R Data Privilege Settings
The H/R tab screen is used to update Human Resource privileges for the user. The H/R screen appears as follows:

The following table gives a description of the screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incidents</td>
<td>This group of check boxes determines if the user can add, change, or delete incidents in the database.</td>
</tr>
<tr>
<td>Position Assignment</td>
<td>This group of check boxes determines if the user can add, change, or delete position assignments in the database.</td>
</tr>
<tr>
<td>Availability</td>
<td>This group of check boxes determines if the user can add, change, or delete availability in the database.</td>
</tr>
<tr>
<td>Item Assignment</td>
<td>This group of check boxes determines if the user can add, change, or delete item assignment in the database.</td>
</tr>
<tr>
<td>Skill</td>
<td>This group of check boxes determines if the user can add, change, or delete skills in the database.</td>
</tr>
</tbody>
</table>

Saving...
The SAVE button or the Save option in the File menu will exit the screen after saving any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen without saving any changes.

All The ALL button will turn on all the options available on the current user privilege screen.

Select All The SELECT ALL button will turn on all the privileges available on all the user privilege screens within the notebook.
Schedule Data Privilege Settings
The Schedule tab screen is used to update Scheduling privileges for the user. The Schedule screen appears as follows:

The following table gives a description of the screen:

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate Detail Schedule</td>
<td>This option determines if the user can generate a detail schedule.</td>
</tr>
<tr>
<td>Update Rotation Table</td>
<td>This option determines if the user can update the rotation tables.</td>
</tr>
<tr>
<td>Update Shift Table</td>
<td>This option determines if the user can update the shift tables.</td>
</tr>
<tr>
<td>Modify Detail Schedule</td>
<td>This option determines if the user can modify a detail schedule.</td>
</tr>
</tbody>
</table>

Saving...
The SAVE button or the Save option in the File menu will exit the screen after saving any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen without saving any changes.

All The ALL button will turn on all the options available on the current user privilege screen.

Select All The SELECT ALL button will turn on all the privileges available on all the user privilege screens within the notebook.
**Time Keeping Data Privilege Settings**

The Time Keeping Tab screen is used to update Time Keeping privileges for the user. The Time Keeping screen appears as follows:

The following table gives a description of the screen:

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Employee Time</td>
<td>This option determines if the user can enter employee time.</td>
</tr>
<tr>
<td>Enter Hours by Earning</td>
<td>This option determines if the user can enter hours by earning.</td>
</tr>
<tr>
<td>Close Actual Period</td>
<td>This option determines if the user can close off the actual.</td>
</tr>
<tr>
<td>Update Hours to Payroll</td>
<td>This option determines if the user can update the hours to payroll.</td>
</tr>
<tr>
<td>Earning Translation</td>
<td>This group of check boxes determines if the user can add, change, or delete earning translation tables in the database.</td>
</tr>
</tbody>
</table>

**Saving...**

The SAVE button or the Save option in the File menu will exit the screen after saving any changed data.

**Esc (exit)**

The ESC key, CANCEL button, or Exit option from the file menu will exit the screen without saving any changes.

**All**

The ALL button will turn on all the options available on the current user privilege screen.

**Select All**

The SELECT ALL button will turn on all the privileges available on all the user privilege screens within the notebook.
Resource Planning Data Privilege Settings
The R/P tab screen is used to update Resource Planning privileges for the user. The Resource Planning screen appears as follows:

The following table gives a description of the screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationships</td>
<td>This group of check boxes determines if the user can add, change, or delete relationships in the database.</td>
</tr>
<tr>
<td>Relationship Category</td>
<td>This group of check boxes determines if the user can add, change, or delete relationship categories in the database.</td>
</tr>
</tbody>
</table>

Saving... The SAVE button or the Save option in the File menu will exit the screen after saving any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen without saving any changes.

All The ALL button will turn on all the options available on the current user privilege screen.

Select All The SELECT ALL button will turn on all the privileges available on all the user privilege screens within the notebook.
Selection Group Data Privilege Settings
The Groups Tab screen is used to update selection group privileges for the user. The Group screen appears as follows:

![Groups Tab Screen]

The following table gives a description of the screen:

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection Group Maintenance</td>
<td>This option determines if the user can perform maintenance on selection method of the group.</td>
</tr>
<tr>
<td>Selection Group Load</td>
<td>This option determines if the user can load selection groups.</td>
</tr>
<tr>
<td>Modify Current Selection</td>
<td>This option determines if the user can modify the current selection group.</td>
</tr>
<tr>
<td>Add Selection Group</td>
<td>This option determines if the user can add a selection group.</td>
</tr>
<tr>
<td>Change Selection Group</td>
<td>This option determines if the user can change a selection group.</td>
</tr>
<tr>
<td>Delete Selection Group</td>
<td>This option determines if the user can delete a selection group.</td>
</tr>
<tr>
<td>Force Use of Selection Group</td>
<td>This option restricts the user to only the default selection group of employees.</td>
</tr>
<tr>
<td>Default Selection Group</td>
<td>This is used to enter the name of the employee group that the user will have loaded for them when they logon to the GrandMaster Suite.</td>
</tr>
</tbody>
</table>
Saving... The SAVE button or the Save option in the File menu will exit the screen after saving any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen without saving any changes.

All The ALL button will turn on all the options available on the current user privilege screen.

Select All The SELECT ALL button will turn on all the privileges available on all the user privilege screens within the notebook.
User Defined Data and Screen Definition Privilege Settings
The Define Tab screen is used to update User Defined data privileges for the user. The Define screen appears as follows:

The following table gives a description of the screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Group</td>
<td>This group of check boxes determines if the user can add, change, or delete data groups in the database.</td>
</tr>
<tr>
<td>Screen Definition</td>
<td>This group of check boxes determines if the user can add, change, or delete screen definitions in the database.</td>
</tr>
<tr>
<td>Screen Groups</td>
<td>This group of check boxes determines if the user can add, change, or delete screen groups in the database.</td>
</tr>
<tr>
<td>Data Definition</td>
<td>This group of check boxes determines if the user can add, change, or delete data definitions in the database.</td>
</tr>
<tr>
<td>Data Records</td>
<td>This group of check boxes determines if the user can add, change, or delete data records in the database.</td>
</tr>
</tbody>
</table>

Saving... The SAVE button or the **Save** option in the File menu will exit the screen after saving any changed data.

Esc (exit) The ESC key, CANCEL button, or **Exit** option from the file menu will exit the screen without saving any changes.

All The ALL button will turn on all the options available on the current user privilege screen.

Select All The SELECT ALL button will turn on all the privileges available on all the user privilege screens within the notebook.
Custom Report Privilege Settings
The Reports tab screen is used to update custom report privileges for the user. The Reports screen appears as follows:

The following table gives a description of the screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Custom Reports</td>
<td>This option determines if a user can define custom reports.</td>
</tr>
<tr>
<td>Generate Custom Reports</td>
<td>This option determines if a user can generate custom reports.</td>
</tr>
</tbody>
</table>

Saving... The SAVE button or the Save option in the File menu will exit the screen after saving any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen without saving any changes.

All The ALL button will turn on all the options available on the current user privilege screen.

Select All The SELECT ALL button will turn on all the privileges available on all the user privilege screens within the notebook.
Global Preferences

This option is used to set processing parameters that apply to all users. Selecting the Global Preferences option will bring up the following screen:

- **Global Types Enabled**: The check box is used to turn the use of global earnings, deductions, and accumulators on or off.

- **Earning Search**: The Earning Search list allows the selection of the search technique used to resolve the pay rate for an employee.
  - The selection “Position Search” uses the position codes as the primary qualification to resolve a pay rate.
  - The selection “Earning Search” uses the earning code as the primary qualification to resolve a pay rate.
Both the **G/L Code Treatments** will verify if the G/L code is in the proper format, as set in the **General Ledger Definition** option (see page 112), but only the Validation G/L Codes option will check if the G/L code is on file.

- If the Validation G/L Codes is turned on the G/L code will be looked for within a G/L code validation file. If the code does not appear in this file a message will appear saying the code does not exist in the file.
- If the Parse G/L Codes is turned on the G/L code will be checked for proper format. If the code is not in the proper format a message will appear saying the code has an invalid format.

**Position Rates for GMII**

When the **Position Rates for GMII** is turned on the position pay tables are used to determine the pay rate for hours being updated to the GMII payroll through Time Keeping.

**Save**

The **Save** option in the File menu, or the OK button will save any changes made to the data in the screen.

**Esc (exit)**

The **ESC** key, the **Exit** option in the File menu, or the CANCEL button will exit the screen without saving any changes made to the data in the screen.
General Ledger Definition

Selecting the General Ledger Definition option will open the following dialog box:

![General Ledger Code Definition Dialog Box]

The general ledger code format may contain one or more segments of various lengths that total a maximum of sixty characters.
The following table describes the fields contained within the General Ledger Code Definition screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Parts</td>
<td>This field specifies the number of parts for the general ledger code. There can be a maximum of eight parts.</td>
</tr>
<tr>
<td>Fill</td>
<td>This field indicates what type of fill is to be put in if there is any blank space within a part of the general ledger code. The fill can be either a zero or a space.</td>
</tr>
<tr>
<td>Separator</td>
<td>The separator indicates what character, if any, will separate the parts of the code. This can be any character on the keyboard.</td>
</tr>
<tr>
<td>Length</td>
<td>The length specifies the number of characters within a part. The general ledger code can be a maximum of 60 characters long. Thus a part can be from zero to 60 characters long, but the sum of all parts must not exceed 60 characters.</td>
</tr>
<tr>
<td>Type</td>
<td>The type defines whether each part is right or left justified.</td>
</tr>
</tbody>
</table>

**Saving...**
The **Save** option in the File menu, or the OK button will save any changes made to the data in the screen.

**Esc (exit)**
The **ESC** key, the **Exit** option in the File menu, or the **CANCEL** button will exit the screen without saving any changes.
Initialization Parameters

The following dialog box will appear when the **Initialization Parameters** option is selected:

Each page of the notebook contains the data directory for the data files and a check box to indicate that the module is “installed” (available to the users).

The “INI File” field contains the name of the file in which the initialization parameters will be saved. This file name is used in the definition of the program start up icon. It follows the name of the executable file to tell the program what set of initialization parameters to use.

If you are running payrolls or other modules for separate companies you may wish to have a different “INI” files for each company to keep the employee files completely separate and confidential.
The following notebook pages are available:

<table>
<thead>
<tr>
<th>Notebook Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin</td>
<td>Contains the name and location of the administration and common data directories. A check box is available to mark the administration module as available to users. This check box should normally be “checked”.</td>
</tr>
<tr>
<td>Payroll</td>
<td>Contains the name and location of the main payroll directory and a check box to mark the module as available to the users.</td>
</tr>
<tr>
<td>H/R</td>
<td>Contains the name and location of the main human resources directory and a check box to mark the module as available to the users.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Contains the name and location of the main directory and a check box to mark the module as available to the users.</td>
</tr>
<tr>
<td>TimeKeep</td>
<td>Contains the name and location of the main time keeping directory and a check box to mark the module as available to the users.</td>
</tr>
<tr>
<td>Res. Plan</td>
<td>Contains the name and location of the main resource planning directory and a check box to mark the module as available to the users.</td>
</tr>
<tr>
<td>EFT</td>
<td>Contains the name and location of the main electronic funds transfer directory and a check box to mark the module as available to the users.</td>
</tr>
<tr>
<td>BankRec</td>
<td>Contains the name and location of the main bank reconciliation directory and a check box to mark the module as available to the users.</td>
</tr>
<tr>
<td>Lab. Dist.</td>
<td>Contains the name and location of the main labour distribution directory and a check box to mark the module as available to the users.</td>
</tr>
<tr>
<td>GMII</td>
<td>Contains the name and location of the main GMII payroll directory. Also contains a check box indicating that GMII is installed as an active live payroll. Used by a very limited number of current Can-Pay Computer Software LTD.’s customers.</td>
</tr>
<tr>
<td>Operation</td>
<td>A check box is available to turn on the “Debug” mode. This is normally not checked.</td>
</tr>
</tbody>
</table>
5 - MANAGING ADMINISTRATION

**Use...**

The *Use...* option in the File menu will temporarily save any changes made to the data on the screen. These changes will be lost when the user logs off the system, thus the changes are only applied to that specific session on GrandMaster Suite.

**Saving...**

The *Save* option in the File menu will permanently save any changes made to the data on the screen.

**Esc (exit)**

The ESC key or the *Exit* option in the File menu will exit from the screen without saving any changes.
The Utilities menu contains general purpose utility programs that are released by Can-Pay Computer Software Ltd. or third party suppliers. This menu currently contains a general purpose **Start Utility Program** option.
Start Utility Program

The Start Utility Program is used to start specialized utility functions that may be released to some users. The utility programs that are started with this option are NOT part of the general release software and should only be used on the direction of your support representative.

**DO NOT USE THIS OPTION TO “PLAY WITH” YOU MAY EXECUTE A FUNCTION THAT WILL RESULT IN DAMAGE TO YOUR DATA FILES.**

The following screen will appear when the Start Utility Program option is selected:

![Start Utility Program Screen](image)

<table>
<thead>
<tr>
<th>Program Name</th>
<th>The name of the utility program to be started should be entered into this data field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Program</td>
<td>The START PROGRAM button starts the program which was entered into the program name field.</td>
</tr>
<tr>
<td>Exit</td>
<td>The EXIT button or the Exit option from the file menu exits the option.</td>
</tr>
</tbody>
</table>

A list of current utility programs and a brief description included in the Grandmaster Suite of programs follows.
Utility Programs

**UTACCADD** Utility to add a pay run’s accumulator balances to the next pay run. This is used to recover from problems with balance carry forwards in some versions of the software.

**UTACCDTH** Utility to MOVE the DOLLAR accumulator balance to the HOURS accumulator balance. This is used to support GMII conversions where the accumulator balance could not be resolved as hours. This problem usually occurs because the accumulator calculation code has been set to number 5 (no calculation), the calculation code is used to determine what accumulator balance is in GMII.

**UTAVALHD** Utility used to re-value an accumulator. The program will use the hour balance of the accumulator multiplied by the pay rate from the accumulator Prime Earning to set the DOLLAR balance of the accumulator. This action is equivalent to the hour Based Revaluation option in the accumulator settings.

**UTAVALDH** Utility used to re-value an accumulator. The program will use the DOLLAR balance of the accumulator divided by the pay rate from the accumulator Prime Earning to set the HOUR balance of the accumulator. This action is equivalent to the Dollar Based Revaluation option in the accumulator settings.

**UTBYPFIX** Utility program to change “Bypassed” transactions to “Processed” transactions or “Processed” transactions to “Bypassed”. This is a special use utility created to fix the transaction status error caused by a bug in the payroll processing.

**UTCA4POS** Utility program to use the code value in the Employee Category 4 field to set the employee base position. This was a special use program created to support some conversions from GMII payrolls.

**UTCATDIS** Utility program to use the code value in the Employee Category 1 field to set the employee base Distribution code. This was a special use program created to support some conversions from GMII payrolls.

**UTCHKEMP** Utility program to verify the integrity of the Employee data file, the Employee to Payroll cross reference file and the Payroll Employee master file. The program will detect any inconsistencies and will insert records to ensure the cross reference between employees and the payrolls are correct. The program can be used to recover from loops in the payroll calculation process when an employee data record has been deleted and the employee shows as an active member of a payroll.

**UTCLREMP** Utility program to DELETE employee data records when the Employee data record is not crossed referenced to a payroll.
UTEMPDAT Utility program to clean up the employee initial, start and end dates in the payroll master file. This was a special use program created to support some conversions from GM1 and GM2 payrolls.

UTHISDEL Utility program to DELETE an employee's pay history from a selected pay run. This is a special support utility used to clean up after problems encountered in some GM2 conversions. IT SHOULD NOT be used unless you know EXACTLY what you are doing.

UTHRSDEL Utility program to DELETE the GENERATED transaction from a pay calculation from the pay hour transaction file. This utility is used to support the re-run of pay calculations after an earlier version of the pay history file is restored. This utility used correctly can assist in recovery of a lost payroll history file without requiring the rekeying of transactions for the pay.

UTJEFGEN Utility program to re-process the journal entry data for a pay run. The program allows you to set different options for the distribution of benefits according to the distribution codes entered for the employee earnings.

UTMAKREV Utility to generate initial review records for employees. The program generates the review for 90 days after the employee start date and used the review type code “3 MTH”.

UTPAYHRS Utility to generate an EXPORT data file containing the transactions for permanent earnings and keyed hourly earnings whose extended amount does not equal the amount calculated from the current rate of pay and the number of hours in the transaction. The records in the export file contain the number of hours from the original record with an amount that is equal to the difference between the calculated amount and the original amount, and the rate equivalent to the difference between the original rate and the current pay rate. The exported transactions can be imported and used as input to a Retro Pay calculation run.

UTRATKIL Utility program to completely ERASE any Earning, Deduction, or Accumulator type definitions that are marked as Deleted.

UTRENJEF Utility program to renumber the Journal Entry file

UTRENPHR Utility program to remember the Payhour file

UTRENUMB Utility program to renumber the Pay History file. The utilities can be used to add 100 to all the pay sequence numbers for a payroll. The program is usually used to insert pay sequence before the “first” run so EI history can be added to a new payroll set up. The inserted pay sequence numbers are dated
according to the number of pay periods in effect and the dates on the “first” pay sequence.

**UTSETHRS**  Utility program to set the “Units” value in employee Earning type records to a specified value. This was a special use program created to support some conversions from GM1 and GM2 payrolls.
This page is intentionally left blank.
File System Errors

On occasion you may encounter a system problem which display a file access error dialog box. We have provided a summary list of these codes and their reason for occurrence and possible action to be taken. In some cases, the remedy may be as simple as exiting the software but at other times the system may be advising of a serious hardware limitation such as not enough disk space remaining on your hard drive to perform the task assigned. It is extremely important to note the error code reference and the path and full file name where the error occurred.

File system errors are displayed in a message box that contains the full path of the file name and a two part error code.
The message box will appear as follows:

Any file error will close down the GrandMaster Suite application.

The following list of error codes is provided to help you diagnose the problem.

One of the file errors

ERROR CODE 1:=9
ERROR CODE 2:=41

... can rarely be corrected using the rebuild utility. Please consult the rebuild section for instructions on using this utility.

We recommend that you always restore your backup files if you encounter a file error. The rebuild utility is NOT a data recovery tool.
## Error Codes

### File Status 9x

9/nnn - Extended file status code as shown below:

<table>
<thead>
<tr>
<th>nnn</th>
<th>Reason for Error</th>
<th>Action to Correct Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Insufficient buffer space. On OS/2, could indicate that the SWAPPATH has not been set correctly or the SWAPPATH drive is full. Could also indicate an out of memory situation.</td>
<td>If a lot of other applications are running on the workstation, end them and re-try the operation.</td>
</tr>
<tr>
<td>002</td>
<td>File not open when access tried</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>003</td>
<td>Serial mode error</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>004</td>
<td>Illegal file name.</td>
<td>May result from an invalid path in the initialization parameters.</td>
</tr>
<tr>
<td>005</td>
<td>Illegal device specification.</td>
<td>May result from an invalid path in the initialization parameters.</td>
</tr>
<tr>
<td>006</td>
<td>Attempt to write to a file opened for input.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>007</td>
<td>Disk space exhausted.</td>
<td>You have filled up your disk drive or exceeded your disk quota on your network. Free up some disk space and restore your backup files.</td>
</tr>
<tr>
<td>008</td>
<td>Attempt to input from a file opened for output.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>009</td>
<td>No room in directory (also, directory does not exist).</td>
<td>Network error or setup limitation.</td>
</tr>
<tr>
<td>010</td>
<td>File name not supplied.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>012</td>
<td>Attempt to open a file which is already open.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>013</td>
<td>File not found.</td>
<td>Check initialization parameters.</td>
</tr>
<tr>
<td>014</td>
<td>Too many files open simultaneously.</td>
<td>Operating system file limits exceeded. Review file statements (refer to system resources).</td>
</tr>
<tr>
<td>015</td>
<td>Too many indexed files open.</td>
<td>Operating system file limits exceeded. Review file statements (refer to system resources).</td>
</tr>
<tr>
<td>016</td>
<td>Too many device files open.</td>
<td>Operating system file limits exceeded. Review file statements (refer to system resources).</td>
</tr>
<tr>
<td>017</td>
<td>Record error; probably zero length.</td>
<td>Will result if previous operations resulted in a “disk full” condition or processing was interrupted by a system crash or hardware fault. Correct hardware faults or free up disk space depending on the conditions, then restore your most recent back up.</td>
</tr>
<tr>
<td>nnn</td>
<td>Reason for Error</td>
<td>Action to Correct Error</td>
</tr>
<tr>
<td>-----</td>
<td>----------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>018</td>
<td>Read part record error: EOF before EOR or file open in wrong mode.</td>
<td>Will result if previous operations resulted in a “disk full” condition or processing was interrupted by system crash or hardware fault. Correct hardware faults or free up disk space depending on the conditions, then restore your most recent backup.</td>
</tr>
<tr>
<td>019</td>
<td>Rewrite error: open mode or access mode wrong</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>020</td>
<td>Device or resource busy.</td>
<td>Network error.</td>
</tr>
<tr>
<td>021</td>
<td>File is a directory.</td>
<td>Possible network or operating system error.</td>
</tr>
<tr>
<td>022</td>
<td>Illegal or impossible access mode for OPEN.</td>
<td>Possible network or operating system error.</td>
</tr>
<tr>
<td>023</td>
<td>Illegal or impossible access mode for CLOSE.</td>
<td>Possible network or operating system error.</td>
</tr>
<tr>
<td>024</td>
<td>Disk I/O error.</td>
<td>Possible network or operating system error.</td>
</tr>
<tr>
<td>025</td>
<td>Operating system data error.</td>
<td>Possible network or operating system error.</td>
</tr>
<tr>
<td>026</td>
<td>Block I-O error.</td>
<td>Possible network or operating system error.</td>
</tr>
<tr>
<td>027</td>
<td>Device not available.</td>
<td>Possible network or operating system error.</td>
</tr>
<tr>
<td>028</td>
<td>No space on device.</td>
<td>Possible network or operating system error.</td>
</tr>
<tr>
<td>029</td>
<td>Attempt to delete open file.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>030</td>
<td>File system is read only.</td>
<td>Network or operating system error.</td>
</tr>
<tr>
<td>031</td>
<td>Not owner of file.</td>
<td>Network or operating system error.</td>
</tr>
<tr>
<td>032</td>
<td>Too many indexed files, or no such process.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>033</td>
<td>Physical I-O error.</td>
<td>Hardware error</td>
</tr>
<tr>
<td>034</td>
<td>Incorrect mode or file descriptor</td>
<td>Network or operating system error.</td>
</tr>
<tr>
<td>035</td>
<td>Attempt to access a file with incorrect permission.</td>
<td>Network or operating system error.</td>
</tr>
<tr>
<td>036</td>
<td>File already exists.</td>
<td>Network or operating system error.</td>
</tr>
<tr>
<td>037</td>
<td>File access denied.</td>
<td>Network or operating system error.</td>
</tr>
<tr>
<td>038</td>
<td>Disk not compatible.</td>
<td>Network or operating system error.</td>
</tr>
<tr>
<td>039</td>
<td>File not compatible.</td>
<td>Network or operating system error.</td>
</tr>
<tr>
<td>040</td>
<td>Language initialization not set up correctly.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>041</td>
<td>Corrupt index file.</td>
<td>File information has been destroyed or corrupted, due to an improper shut down, system crash or hardware fault. Correct situation with hardware, if appropriate, and restore your backups.</td>
</tr>
<tr>
<td>nnn</td>
<td>Reason for Error</td>
<td>Action to Correct Error</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>042</td>
<td>Attempt to write on broken pipe.</td>
<td>File information has been destroyed or corrupted. Correct situation with hardware, if appropriate, and restore your backups.</td>
</tr>
<tr>
<td>043</td>
<td>File information missing for indexed file.</td>
<td>File information has been destroyed or corrupted due to an improper shut down, system crash or hardware fault. Correct situation with hardware, if appropriate, and restore your backups.</td>
</tr>
<tr>
<td>045</td>
<td>Attempt to open an NLS file using an incompatible program.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>047</td>
<td>Indexed structure overflow. (Could indicate that you have reached the maximum number of duplicate keys.)</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>065</td>
<td>File locked.</td>
<td>May occur if file backup software is processing a file required by the application.</td>
</tr>
<tr>
<td>066</td>
<td>Attempt to add duplicate record key to indexed file.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>067</td>
<td>Indexed file not open.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>068</td>
<td>Record locked.</td>
<td>Re-try operating without other users logged in.</td>
</tr>
<tr>
<td>069</td>
<td>Illegal argument to ISAM module.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>070</td>
<td>Too many indexed files open.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>071</td>
<td>Bad indexed file format.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>072</td>
<td>End of indexed file.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>073</td>
<td>No record found in indexed file.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>074</td>
<td>No current record in indexed file.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>075</td>
<td>Indexed data file name too long.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>077</td>
<td>Internal ISAM module failure.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>078</td>
<td>Illegal key description in indexed file.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>081</td>
<td>Key already exists in indexed file.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>100</td>
<td>Invalid file operation.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>101</td>
<td>Illegal operation on an indexed file.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>102</td>
<td>Sequential file with non-integral number of records.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>104</td>
<td>Null file name used in a file operation.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>105</td>
<td>Memory allocation error.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>129</td>
<td>Attempt to access record zero of relative file.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>135</td>
<td>File must not exist.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>138</td>
<td>File closed with lock - cannot be opened.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>nnn</td>
<td>Reason for Error</td>
<td>Action to Correct Error</td>
</tr>
<tr>
<td>------</td>
<td>------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>139</td>
<td>Record length or key data inconsistency.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>141</td>
<td>File already open - cannot be opened.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>142</td>
<td>File not open - cannot be closed.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>143</td>
<td>REWRITE/DELETE in sequential mode not preceded by successful READ.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>146</td>
<td>No current record defined for sequential read.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>147</td>
<td>Wrong open mode or access mode for READ/START.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>148</td>
<td>Wrong open mode or access mode for WRITE.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>149</td>
<td>Wrong open mode or access mode for REWRITE/DELETE.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>151</td>
<td>Random read on sequential file.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>152</td>
<td>REWRITE on file not opened I-O.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>158</td>
<td>Attempt to REWRITE to a line-sequential file.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>159</td>
<td>Malformed line sequential file.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>161</td>
<td>File header not found.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>173</td>
<td>Called program not found.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>180</td>
<td>End-of-file marker error.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>182</td>
<td>Console input or console output open in wrong direction.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>183</td>
<td>Attempt to open line sequential file for I-O.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>188</td>
<td>File name too large.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>193</td>
<td>Error in variable length count.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>194</td>
<td>File size too large.</td>
<td>Restore your most recent backup.</td>
</tr>
<tr>
<td>195</td>
<td>DELETE/REWRITE not preceded by a READ.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>196</td>
<td>Record number too large in relative or indexed file.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>210</td>
<td>File is closed with lock.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>213</td>
<td>Too many locks.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>218</td>
<td>Malformed MULTIPLE REEL/UNIT file.</td>
<td>Contact Can-Pay.</td>
</tr>
<tr>
<td>219</td>
<td>Operating system shared file limit exceeded.</td>
<td>This error normally occurs when too many applications are sharing file on a network file server. The file server setup should be reviewed by your network administrator.</td>
</tr>
</tbody>
</table>
OVERVIEW

The File Management utility, Rebuild, provides a number of facilities to improve the management of data files. The principal facilities offered are:

- indexed file reorganization
- recovery of corrupt indexed files.

Indexed File Reorganization

As indexed files are updated, by adding, deleting and altering records, the index and data structures become disjointed, making processing less efficient. In addition, space left by deleted records is not always reused, thus making the file bigger than it needs to be. After a large number of changes have been made, it is worth reorganizing an indexed file to rebuild the data and indices in an ordered sequential fashion and reclaim any free space, thus providing optimum performance and integrity.

Recovery of Corrupt Indexed Files

An index can become corrupt if, for example, a power loss occurs when a program has opened and changed an indexed file, but has not yet closed it. If a COBOL program subsequently attempts to open this file, then the Run Time System (RTS) will detect that the file was not closed properly and will return a file status error for “Corrupt Index file”. You cannot use the file at all without first recovering its integrity.

Rebuild can recover corrupt indexed files for you. If the data portion of the file is intact and only the index portion is corrupt, then Rebuild can generate a new index (idx file) from the data with no information loss. If the data portion of the file is corrupt then Rebuild can rebuild a complete new indexed file, both data and index portions, but there will be a loss of information as Rebuild discards any corrupt data records that it encounters.
Rebuild file Index Utility

The rebuild utility may be used to recover from certain file system errors. Even when the rebuild procedure completes successfully there is no guarantee that no loss of data may have occurred. Your first and only sure recovery method should be your backup files.

The build utility requires exclusive use of the files. Ask all other users to exit out of the Suite before attempting a recovery.

The most common use is to rebuild a file index when a 9/41 error has been encountered.

The command line would be:

REBUILD path\filename /v

Where path\filename is the name of the file that was displayed in the file system error message box.
OPERATION

The Rebuild utility is a non-interactive utility, which accepts all of its parameters from the command line, or from parameter files named on the command line. See the section Parameter Files later in this chapter for details of how to create a parameter file.

The "/" characters shown in the following formats for introducing parameters are for DOS, Windows and OS/2. On UNIX, please replace these "/" characters by "-" characters.

The format of the command line for rebuilding an index is:

```
rebuild in-file [/c..] [/k..] [/i] [/v] [/e]
```

and for reorganization:

```
rebuild in-file, out-file [/c..] [/d] [/x..] [/i] [/v]
```

where:
- \textit{in-file} is the name of the file, including its extension, to be rebuilt/reorganized.
- \textit{out-file} is the name of the file, including its extension, to contain the result. The root of the file-name must be different from that of \textit{in-file}.
- \textit{/c} specifies the type of compression to enable on a file.
- \textit{/d} causes Rebuild to continue from the beginning of the next record if it finds that the data part of a record in an indexed file is corrupted.
- \textit{/e} prevents an illegal duplicate key from aborting the Rebuild process.
- \textit{/i} causes Rebuild to display information.
- \textit{/k} defines the key structure of the output file.
- \textit{/n} causes Rebuild to display information without processing the file.
- \textit{/r} defines the record structure of the input file and output files.
- \textit{/t} specifies the index file format of the output file.
- \textit{/v} causes Rebuild to display a running record count.
- \textit{/x} indicates the key-of-reference.

The utility assumes that an index rebuild is required instead of a reorganization if no output file is specified. A rebuild with no options can only be achieved if the key information in the index file is not corrupt. If the index part (idx) of the indexed file does not exist, then it is possible to completely rebuild it by additionally specifying a key structure option. This process also makes it possible to replace the key structure of an existing indexed file with an alternative structure, simply by running Rebuild in this mode with a new key specification. Environment variables named in-file or out-file cause filename mapping.
Rebuild Options

Various options are available with the Rebuild utility. These are described below. Some of the options are followed by parameters providing the information. The option letter can be separated from its parameters by an optional colon (:). Options may be placed anywhere within the command, and are free-format with spaces allowed between any fields.

/c
The /c option allows the specification of compression on files. The parameters are the letter d for data compression followed by an integer, and the letter i for index compression followed by an integer. The integer for data compression must be in the range 0 to 255 where 0 denotes no compression, values of 1 through 127 are reserved, and 128 through 255 are for user-defined compression routines. The integer for index compression must be in the range 0 to 7 which corresponds to the type of compression:

- 1 - compression of duplicates
- 2 - compression of leading characters
- 4 - compression of trailing spaces

You can specify any combination by adding these values together. Zero (0) specifies no index compression.

Example:

/c:d1i7  Specifies data compression routine 1, and index compression of leading characters and trailing spaces.
This compression option is the one used in GrandMaster Suite.
/ci1    Specifies index compression of duplicates only.

Data compression applies only to an output file; index compression can apply to an output file or the rebuild of an existing file. The /c options operate in a similar manner to the Compiler directives DATACOMPRESS and KEYCOMPRESS. Refer to the appendix Directives for Compiler for details of the values available.
/d
The /d option causes Rebuild to continue from the beginning of the next record if it finds that the data part of a record in an indexed file is corrupted. If the /d option is not set, Rebuild returns file status error 9/18 (Read part record error: EOF before EOR or file open in wrong mode) when it encounters a corrupted record.
When the /d option is specified, the input file's file header is read in and the output file is given the same attributes.
This option works best with decompressed files which give 9/18 errors when rebuilding. Rebuild does try to recover other file types but its resulting output may not be what you are expecting.
If you specify other Rebuild options (for example, /k) with the /d option, then the other options take precedence over the details in the file header.

/e
When rebuilding a corrupt file, or a file with a new key structure (/k option used), records may be encountered with an illegal duplicate key. Without the /e option this causes Rebuild to terminate with an “Error on output file - status 22” error. However, if the /e option is used, Rebuild reports the duplicate, and continues to process the remaining records. Note that the record with the duplicate key is not written.

/i
When the /i option is selected, Rebuild will display information about the input and output files, including record lengths, file type and key structure.

It is not possible to obtain information about a file without actually invoking one of the operations.

Example: The information for the index rebuild:
rebuild mast/i
Rebuild successful - records read=49
File : MAST
Largest record length - 353  Smallest record length - 353
Average record length - 353  Organization - Indexed Recording mode - Fixed
Maximum record length - 353  Minimum record length - 353
Keys description: Start char Length Key - 0 1 +9
The /k option defines the key structure for an indexed file. This is used for rebuilding the index of an indexed file where the index part is missing or corrupt. The parameters for this option define the keys. The definition of a key is separated from the definition of the next key by a colon (:). Each key can be defined as a number of parts (split key), each part being separated by a comma (,). The key part is defined by start character position and length in characters, separated by a plus (+) or L. Alternate keys (those other than the first defined) can be terminated by an additional parameter, the character d, if they are defined as WITH DUPLICATES. The first character position in a record is position 1.

Example:

/k:1+20
defines a single key, starting at character position 1, length 20 characters
/k:5+5:20+1d:40+2,43+10
defines three keys, the third being split, and the second allowing duplicates. The first key, the record key, starts at character position 5, length 5; the second key, an alternate key allowing duplicates, starts at 20, length 1; and the third key, a split alternate key, has two parts, the first starting at 40, length 2, the second at 43, length 10.

This option applies only to an existing file, unless you are using it to create an index for a relative or sequential file (see the section The /o Option) for which you are allowed to specify an output file.

The /n option causes Rebuild to display information about the file, as for /i, but without doing any other processing on the file.

The /o option defines the organization of the file to be converted. If the parameter is omitted, indexed is assumed. The organization is identified by a single letter parameter, as follows:

/o:s sequential /o:r relative /o:i indexed (the default)
The output file has the same organization as the input file, but in a format suitable for this COBOL system. However, you can create indexed files from sequential and relative files by adding the letter i after the s or r. To create an index, you specify the key structure with the /k option. The index file along with its data part is created separately to the original, so you must specify a name for the output file.
Example:

/o:ri:k:1+2:3+10d
converts a relative file into an indexed file with the key structure specified.

Notes: Files of the format used by this COBOL system which are processed by Rebuild must have a variable structure file header. Therefore, fixed length sequential or fixed length relative files are not processed because they do not have variable structure file headers.

You can create fixed length sequential or relative files with variable structure file headers by retaining the record length information in the COBOL creating program and by adding a RECORDING MODE IS VARIABLE clause to the FD of your program.

/r
The /r option defines the record lengths and recording mode of a file. Usually, this information is obtained by Rebuild from the input file and transferred directly to the output file. However, when converting to and from Btrieve format files using the /s and /t options, you must consider the following. Some index file features are implemented differently by Btrieve. An example is that Btrieve does not store the maximum record length. Therefore, on conversion from a COBOL format file to a Btrieve file and back again, certain record length and recording mode information can be lost. This makes the file unreadable to a COBOL program using the original file description. Using the /r option, you can specify the record length and recording mode information on the command line when converting to retain the correct record definitions. You can determine the correct options from the COBOL format file using the /n information option.

Example:

/r:f record-length
Specifies a fixed length record format with records of length record-length; for example, /r:f100.

/r:v min-record-length max-record-length
Specifies a variable length format with the maximum and minimum record lengths separated by a hyphen; for example, /r:v100-200.
The /s option is for converting file formats used by other COBOL system to the format used by this system. You specify the input file format as follows:

<table>
<thead>
<tr>
<th>Format Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/s:btrv</td>
</tr>
<tr>
<td>/s:c-isam</td>
</tr>
<tr>
<td>/s:lii</td>
</tr>
<tr>
<td>/s:mf</td>
</tr>
<tr>
<td>/s:mf4</td>
</tr>
</tbody>
</table>

Example:

/s:c-isam

converts a C-ISAM format file into the format used by this system.

By default the output file is in the format used by this system, but this option can be used in conjunction with the /t option to convert from one file format to another while reorganizing the file at the same time. You cannot use this option to rebuild a corrupt or deleted index of a C-ISAM, a LEVEL II V2.5 COBOL or a Btrieve format file by means of a command line such as:

```
rebuild infile.dat /s:c-isam
```

Only indexed files in the format used by this system can be rebuilt. You should use the /s option to convert your files into this format so that they can be rebuilt in the event of corruption.

When rebuilding the index of a duplicate key format (mf4) file, you should specify the /s:mf4 option on the command line otherwise Rebuild attempts to process the command line as if it is a normal format file (mf).

Example:

```
rebuild infile.dat /k:1+10:10+2d /s:mf4
```

I/O operations on Btrieve files are performed by a separate Btrieve file handler. You must invoke this before Rebuild performs any conversions involving Btrieve files. If you do not, error 9/27 (Device not available) is returned. See your Btrieve documentation for details of how to set up and invoke the Btrieve file handler.
/t
The /t option allows the specification of the index file format of the output file. You specify the output file format as follows:

<table>
<thead>
<tr>
<th>Format Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/t:btrv</td>
</tr>
<tr>
<td>/t:c:isam</td>
</tr>
<tr>
<td>/t:ili</td>
</tr>
<tr>
<td>/t:mf</td>
</tr>
<tr>
<td>/t:mf4</td>
</tr>
</tbody>
</table>

This option applies only to an output file so output file must be specified. 
I/O operations on Btrieve files are performed by a separate Btrieve file handler. You must invoke this before Rebuild performs any conversions involving Btrieve files. If you do not, error 9/27 (Device not available) is returned. See your Btrieve documentation for details of how to set up and invoke the Btrieve file handler.

/v
When the /v option is present, Rebuild will display a record count which increments as it processes the file. This is useful if you want to keep track of how Rebuild is progressing.

Do not use the /v option if you are redirecting the output.

/x
The /x option defines the key-of-reference, which is used to define the order in which the data will be written when reorganizing an indexed file. The parameter for this option is the number of the key to be used. The record key is 0, the alternate keys are numbered, starting at 1, in the order they are specified in the SELECT statement in the creating program. If no /x option is specified then the record key (key 0) is assumed.

Example:

/x:2
causes the data to be organized in the order specified by the second alternate key in the SELECT clause of the creating program.
Examples of Operation

rebuild badms001.dat, ms001.dat /i
- reorganizes the given file, assuming it is an indexed file in the format used by this system. The data will be written in the order of the record key, and information displayed when the reorganization is complete.

rebuild badms001.dat, ms001.dat /x:3
- reorganizes the given file, assuming it is an indexed file in the format used by this system. The data is written in the order of the third alternate key.

rebuild ms001.dat
- rebuilds the index of the given file, assuming it is an indexed file in the format used by this system, and that the index (.idx) file is still present, and the key information held therein is not corrupted.

rebuild ms001.dat /k:1+20 /i
- rebuilds the index of the given file, assuming it is an indexed file in the format used by this system. The index (.idx) file does not need to exist, and is ignored if it does. It will be completely recreated using the key definition specified on the command, which need not correspond to the key definition used when the file was created. Information about the file will be displayed when the rebuild ends.

rebuild infile.dat, outfile.dat /t:btrv
- converts a file in a format used by this COBOL system to a Btrieve format file.

rebuild infile.dat, outfile.dat /s:btrv /t:mf /r:v12-20
- converts a Btrieve format file to a format used by this COBOL system and sets the recording mode to variable, the minimum record length to 12 and the maximum record length to 20.

rebuild infile.dat, outfile.dat /s:c-isam /c:d1
- converts a C-ISAM format index file into the format used by this system and compresses the data part.

rebuild infile.dat, outfile.dat /o:ri /k:1+2:3+10d /c:i7
- generates an index with all types of key compression for a relative file.

rebuild infile.dat, outfile.dat /s:lii /t:lii
- reorganizes a LEVEL II V2.5 COBOL format file and retains the LII structure on the output file. It is possible to combine /s and /t with other formats in a similar manner.

set data=\tmp.dat rebuild data /i
- reorganizes and displays information about the file \tmp.dat.
Parameter Files

At any point on the command line, an at character (@) followed by a file-name indicates that parameters should be taken from the named file. The contents of the file are treated as if they were part of the command line, replacing the @file-name. The parameter file is an ASCII text file. The parameters can be specified in free-format, with spaces being non-significant. (Line ends are treated as spaces.) The file must not be bigger than 1024 bytes. Comments can be included in the file by preceding them with an asterisk (*). Anything following the asterisk is treated as a comment, up to the end of the line.

Example:

rebuild badms001.dat, ms001.dat @ms001.par

where ms001.par is an ASCII text file containing the following line:
/k:1+20, 25+5:40+12:60+3, 85+10d

or the following lines (which are equivalent to the line above):

* Works master file - key parameters /k: 1+20 * prime key - first part 25+ 5: * - second part 40+12 : * 1st alternate key 60+ 3 , * 2nd alternate key (with duplicates) * - first part 85+10d * - second part

If a parameter in a parameter file is in error, then a suitable message is displayed. The parameter file line in error is not displayed, but the command line is.
Redirection of Information

All information displayed by the utility can be redirected to a text file using the standard operating system redirection, for creating a new file and > for extending an existing file. Hence, the results of a number of rebuilds in a batch stream can be collected as the stream is processed, and viewed on completion.

Example:

rebuild oldms001.dat,ms001.dat /k:1+20 /i rebuild.prt rebuild oldrt549.seq,rt549.seq /i > rebuild.prt rebuild badms001.dat,ms001.dat @ ms001.par > rebuild.prt

causes the information for all three operations to be placed in the text file, rebuild.prt, one after the other. This can be viewed later using a text editor or the operating system TYPE command.

Note that you must not use the /v option when you are redirecting output.
General Notes

1. We recommend you to take a backup copy of the file being rebuilt or reorganized before using Rebuild. Rebuild takes every precaution to prevent the original files being corrupted, but it can happen if the command line is incorrectly specified. Also, when doing an index rebuild, the original index is overwritten, so it would be wise to preserve it in case there are any subsequent problems. For indexed files in the format used by this system, you should save both the data and the index (IDX) file.

2. The facility to rebuild the index of an indexed file does not retain the information held in the original about free space in the data file (Data Free Space Record). Consequently, this free space cannot be reused and your file may grow bigger than necessary. To overcome this problem you are recommended to reorganize the file after you have rebuilt the index, thus removing all of the free space.

(Free space consists of the spaces in the data file occupied by deleted records. Information about these areas is normally retained, and the areas reused for new records as appropriate.)

3. When the rebuild process is complete, the data file is changed because a blank Data Free Space Record is added to the end of the file. Each time you rebuild the index a new record is added. Consequently, several rebuilds, without intervening reorganizations, cause the data file to grow. Again, this problem can be eliminated by reorganizing the file, causing all the Data Free Space Records to be removed, and a single new blank one added. (See the appendix File Formats for more details about indexed file structures.)

SYSTEM PARAMETERS

A set of special parameters can be specified immediately following Rebuild on the command line. These parameters are present for use during development, testing and support of Rebuild. Each parameter consists of two slashes followed by a letter followed by a space.

The “//” characters are for DOS, Windows and OS/2. On UNIX, please replace “//” by “—”.

//q prevent banners from being displayed
//v display version number of Rebuild program itself
ERROR, INFORMATION AND WARNING MESSAGES

Rebuild will output an Error, Information or Warning message if you do not specify the correct command line when rebuilding, converting or reorganizing an indexed file. The following sections list these messages with an explanation of the message and, for Error and Warning message, a solution.

Errors

When an error is encountered, the command line is displayed, followed by an error message. For command line errors, a caret (\^) is displayed under the point in the command line that the error was detected. The program sets the return code to a value other than zero to indicate the type of error that has occurred. The code can be tested in a batch file using the IF ERRORLEVEL command.

The most likely cause of errors is specifying parameters to Rebuild that do not correctly represent the input file. In most cases it is difficult for the utility to determine that such a mistake has been made, since most data files carry insufficient information to make them easy to identify. Consequently, the error presented by the utility may not obviously identify the cause.

Command Line Errors:

If a command line error occurs, the return code will be set to 9.

***Invalid parameter combination
- The parameters specified on the command line are not compatible with each other. The return code is set to 9.
- Specify valid parameters for the options you want to use.

/k option is required for conversion to indexed file
- No key definition was given for the index of the file being generated from a sequential or relative file.
- Specify a key definition.

Data compression out of range
- The integer you specified for data compression is not within the allowable range.
- Data compression requires an integer in the range 0 through 255.

Data compression specified more than once
- You have specified the option for data compression more than once; that is, /c/[dn][dn]
- The correct format is /c/[dn][in]

Input file same as output file
- You have given the output file the same name as the input file.
- The output file-name must be different from the input file-name.

Index compression out of range
- The integer you specified for index compression is not within the allowed range.
- Index compression requires an integer in the range 0 to 7.

Index compression specified more than once
- You have specified the option for index compression more than once; that is, /c[ln][in].
- The correct format is /c[dn][in].

Invalid command - /n not allowed with Microsoft format file
- You have specified the /n option for a Microsoft format file which you cannot do unless the Microsoft format file has been converted into the indexed file format used by this system.

You must either reenter the command line without the /n option, or convert the Microsoft format file to the indexed file format used by this system and enter the command line again.

Invalid command - must specify output file for conversion
- You have omitted an output file-name for a conversion.
- You must specify an output file-name when you want to convert a file to a different format.

Invalid command line
- The command line contains an error other than those described above.
- Check carefully the syntax, spelling, and spacing in the command line you are trying to enter.

Invalid compression choice - must be 'd' or 'i'
- The specification of data or index compression was not correct.
- When you want to specify data or index compression, you must specify the d or i parameters.

Invalid format
- The integer you specified for index file format is not within the allowable range.
- Index file formats require an integer in the range 0 to 4.

Invalid key length - cannot be zero
- One of the keys you defined has a zero length, which is illegal. (This may be due to incorrect use of separator characters.)
- Make sure that any keys you define have a valid start character.
Invalid key specification - key not contained in record
- One of the keys, as defined, is not wholly contained in the record. This is illegal.
- For variable length records, the key must be wholly contained in the minimum length record.

Invalid key start - cannot be zero
- One of the keys defined has a start character position of zero, which is illegal.
  (This may be due to incorrect use of separator characters.)
- Make sure that any keys you define have a valid start character.

Invalid key structure - 'k' expected
- A key part parameter of the /k option is incorrect.
- It must be start character position and length separated by a plus (+) or L.

Invalid option
- You have specified an invalid option.
- The options you can specify are described earlier in this chapter.

Invalid organization
- The syntax of the /o option is incorrect.
- The only valid organizations you can specify with the /o are s (sequential), r (relative), or i (indexed).

Invalid organization - 'i' or nothing expected
- The syntax of the /o option is incorrect.
- The only valid characters after the i, s or r are the letter i (when converting to an indexed file) or a '/', when another option is specified.

Invalid organization - must be indexed for index rebuild
- You have tried to rebuild the index of a file whose organization is sequential or relative.
- Make sure that the file-name you enter for rebuilding is that of an indexed file. If it is not, the rebuild will fail. See the section The /o Option earlier in this chapter for further information.

Invalid organization - must be indexed for reorganization
- You have tried to reorganize a file index for a file whose organization is sequential or relative.
- Make sure that the file-name you enter for reorganization is that of an indexed file. If it is not, reorganization will fail. See the section The /o Option earlier in this chapter for further information.

Invalid record length - cannot be zero
- You have specified that the length of a record is zero. This is invalid.
When specifying record lengths, you must specify a length greater than zero which falls within the limits for record lengths for this COBOL system. See the appendix File Formats later in this manual for further details.

Invalid record lengths - maximum must not be less than minimum
- The integers you have used to specify the maximum and minimum lengths of a record indicate that the maximum length is less than the minimum length. This is invalid.
- Reenter the maximum or minimum record length again, ensuring that the maximum length is greater than the minimum length.

Invalid record parameter - 'L' expected
- When specifying the record structure of a variable length file, you have not separated the minimum record length and the maximum record length with a 'L'.
- The correct format is /r: Vminrelen-maxrelen

Invalid record type - 'F' or 'V' expected
- You have entered record type other than fixed or variable. This is invalid.
- Reenter the record type using either f (fixed) or v (variable).

Invalid source format
- The format of the /s option is incorrect.
- See the section The /s Option earlier in this chapter for details of the valid format and parameter to specify with this option.

MS2X specified for non-indexed file
- You have specified that you want to convert a Microsoft COBOL indexed file when that file is not indexed.
- Make sure that you are using the /s option and the correct parameter. See the Compatibility Guide for details of this option.

Must have key definition (/k option) with MS2X
- The Microsoft key file is not present.
- You must specify the /k option to enable Rebuild to set up the keys for this file.

No output file specified for /t to refer to
- You did not specify a name for the output file which was referred to with the /t option.
- Specify the name of an output file for this option.

No output file specified for data compression
- You did not specify an output file-name for data compression.
- Specify a valid output file-name

Number expected
- You have specified another character where a number was expected.
- Specify a numeric value for this parameter.

Output file was not specified for indexed output
- No name was given for the output file in conversion to an indexed file.
- Specify an output file-name.

Parameter file not found
- The parameter file specified on the command line cannot be found.
- Check the file exists, and the specification used on the command line is correct.

Rebuild Errors:

***Error on input file - bad file structure
- The structure of the input file is not an indexed file in the format used by this system. The return code is set to 1.
- Ensure that the parameters are correct and that the file is not corrupt.

***Error on input file - Communications failure
- This error occurs if you have an Fhredir configuration which tells Rebuild to access files through Fileshare Version 2 (an add-on product).
- Remove this configuration.

***Error on input file - Disk input output error
- This indicates a hardware fault. You should contact your system administrator if you receive this error.

***Error on input file - disk space exhausted
- File processing cannot continue because there is insufficient disk space to do so.
- Ensure that the input file is not corrupt. The output file is closed and should be usable, if not complete.

***Error on input file - duplicate key - record not written:
- The duplicate key was not written to the output file as this would have created an invalid duplicate.

***Error on input file - file is not a BTRIEVE indexed file
- The file specified by /s:btrv was not recognized as a Btrieve indexed file. The return code is set to 1.
- Make sure that the file you specify is a Btrieve indexed file.

***Error on input file - file is not a C-ISAM indexed file
- The file specified by /s:c-isam was not recognized as a C-ISAM indexed file.
- The return code is set to 1.
- Make sure that the file you specify is a C-ISAM indexed file.
***Error on input file - file is not an LII indexed file
- The file specified by /sl:ii was not recognized as a LEVEL II V2.5 COBOL indexed file. The return code is set to 1.
- Make sure that the file you specify is a LEVEL II V2.5 COBOL indexed file.

***Error on input file - file is not an MF indexed file
- The file specified by /s:mf was not recognized as an mf indexed file. The return code is set to 1.
- Make sure that the file you specify is an mf indexed file.

***Error on input file - file is not an MF4 indexed file
- The file specified by /s:mf4 was not recognized as an mf4 indexed file. The return code is set to 1.
- Make sure that the file you specify is an mf4 indexed file.

***Error on input file - file is not a variable relative file
- The file specified by /or is not recognized as a variable relative file. The return code is set to 1.
- Specify a variable relative file.

***Error on input file - file is not a variable sequential file
- The file specified by /os was not recognized as a variable sequential file. The return code is set to 1.
- Specify a variable sequential file.

***Error on input file - File locked
- The file you specified as your input file is locked by another process.
- Try again when the file is free to be accessed.

***Error on input file - file must be indexed for rebuild
- You have chosen to rebuild the index of an indexed file that is in the format used by this COBOL system. The file is in the correct format but it is not an indexed file. The return code is set to 1.
- Check that you have the correct file and have selected the correct action.

***Error on input file - file must be indexed for reorganization
- The input file is not an indexed file in the format used by this system. The return code is set to 1.
- Check that you have the correct file, and that you mean to do a reorganization.

***Error on input file - file not found
- The input file cannot be found. The return code is set to 1.
- Check that the file-name you entered is correct, and the file does actually exist. For reorganization or index rebuild ensure that the index file (.IDX) exists for the given indexed data file.
***Error on input file - illegal filename specified
   ■ A file-name contains an illegal character. This could be any character that is not part of the permitted character set or it could be the system-dependent delimiter, which on most systems is the space.
   ■ Try the file operation again using the correct file-name.

***Error on input file - invalid /x: key-of-reference
   ■ The number specified in the key-of-reference option (/x) exceeds the number of keys for the given file. The return code is set to 1.
   ■ Check the key required, and try again.

***Error on input file - no record size information
   ■ You have specified the /r option without specifying record lengths.
   ■ Make sure that you specify record lengths when you specify the /r option. See the section The /r Option earlier in this chapter for details.

***Error on input file - not MF indexed or variable format
   ■ The input file is not an indexed file, or a variable format file in the format used by this system. The return code is set to 1.
   ■ Make sure that the file you specify is either an indexed file, or a variable file whose format is recognized by this COBOL system.

***Error on input file - record size specified
   ■ The record sizes specified in the /r option do not match those in the file.
   ■ Correct the /r option and try the operation again.

***Error on input file - status xx
   ■ An error, other than one of the above input file errors, has occurred while processing the input file. Possible causes are:

   a) the file does not exist
   b) a hardware error has occurred opening or reading the file
   c) the file is corrupt

The status xx is an ANSI'85 file status. If the first byte is a 9, then the status yyy is a COBOL run-time error number. The output file is closed, and should be usable, if not complete. The return code is set to 1.
   ■ See the Error Messages for more details of run-time errors.

***Error on output file - record length min or max
   ■ The record length of the output file is less than the minimum or greater than the maximum length you specified.
   ■ Change the record lengths specified in the /r option.

***Error on output file - status xx
***Error on output file - status 9/yyyy
An error has occurred processing the output file. Possible causes are that the file cannot be created, or a hardware error has been encountered on opening or writing the file, or the parameters specified are incorrect.

The status xx is an ANSI'85 file status. If the first byte is a 9, then the status yyy is a COBOL run time error number. The return code is set to 2.

- See the Error Messages for more details of run time errors.

Information Messages

The following information messages are output when Rebuild is processing a file:

Converting file

- The file you specified is being converted from one format to another.

Rebuild aborted

- You will receive this error followed by one of the errors given in the section Command Line Errors.

Rebuild successful

- The file you specified has been successfully rebuilt.

Rebuilding file

- The file you specified is being rebuilt.

Rebuilding index

- The index of the file you specified is being rebuilt.

Records processed

- The indicated number of records were processed when the file was converted, rebuilt or reorganized.

Reorganization successful

- The file you specified has been successfully reorganized.

Reorganizing file

- The file you specified is being reorganized.

Warning Messages

Depending on the operation selected, some command line options are unnecessary. In these cases, the incorrect usage will be indicated, but the option will be ignored and processing will continue.

Note that the option may be correct, but omission of other information may have caused Rebuild to select the wrong process. If this is the case, correct the command line and rerun.

** WARNING ** - Option ignored - /k option not needed for a reorganization

- A key definition option has been used when an indexed file reorganization operation has been requested. The option is ignored.
*** WARNING *** - Option ignored - /k option not needed with /n
- A key definition option has been used when an indexed file reorganization operation has been requested. The option is ignored.

*** WARNING *** - Option ignored - /k option not needed for ms2 conversion.
- A key definition option has been used when you have requested a Microsoft COBOL V2.2 conversion. This is not required since the key information is held in the data file of a Microsoft V2.2 indexed file.

*** WARNING *** - Option ignored - /r option not needed for a reorganization
- A record structure for a reorganization has been used when only the /n (information only) option was specified.

*** WARNING *** - Option ignored - /x option not needed for index rebuild
- A key of reference option has been used when an action other than indexed file reorganization has been selected. The option is ignored.

*** WARNING *** - Option ignored - /x option not needed for ms2 conversion.
- A key of reference option has been used when you have requested a Microsoft COBOL V2.2 conversion. This is not required since the key information is held in the data file of a Microsoft V2.2 indexed file.

Micro Focus is a registered trademark of Micro Focus Limited. Micro Focus COBOL, Fileshare, LEVEL II COBOL, and OS/2 are trademarks of Micro Focus Limited. C-ISAM is a trademark of Informix Software Incorporated. OS/2 is a registered trademark of International Business Machines Corporation. Microsoft and XENIX are registered trademarks of Microsoft Corporation. Windows is a trademark of Microsoft Corporation. Btrieve is a registered trademark of Novell, Incorporated. UNIX is a registered trademark of UNIX Systems Laboratories, Inc. 

Copyright (C) 1993-94 Micro Focus Limited